
Commands Default Key Function Keyworthiness Score /10 Notes

Commands: Add Track
Chord, Signature, Tempo, Transpose, and 
Video Tracks are unique in each project. 

This means you can only have one of each 

Add Track… T
Opens a window, from which you can add new tracks of all types. The window can remain 
open if you wish, so that you can keep adding tracks one after another.

10

Arranger Adds an Arranger track, no further input required. 1

Audio
Opens a window, in which the user configures the audio track(s) before creating them. Options 
are input/output routing, naming, and how many tracks to create.

1

Audio Mono
Adds an audio mono track, without further user input. Naming starts as "Audio 01" and keeps 
going.

3

Chord Adds a Chord Track, without further user input. 0
Folder Opens a window, in which the user can name the folder before creating it. 1

FX Channel
Opens a window, in which the user configures the effects track(s) before creating them. 
Options are: effect choice, configuration of inputs/outputs, creating inside a folder or outside a 
folder, naming, and how many tracks to create.

3

Group
Opens a window, in which the user configures the group track(s) before creating them. Options 
are: Configuration of inputs/outputs, creating inside a folder or outside a folder, naming, and 
how many tracks to create.

3

Instrument
Opens a window, in which the user configures the instrument track(s) before creating them. 
Options are: Instrument choice, configuration of output, and how many tracks to create.

1

Marker
Opens a window, in which the user names the marker track(s) before creating them. Options 
are: Name, how many tracks to create.

1

MIDI
Opens a window, in which the user names the MIDI track(s) before creating them. Options are: 
Name, how many tracks to create.

1

Ruler
Opens a window, in which the user names the Ruler track(s) before creating them. Options are: 
Name, how many tracks to create.

1

Sampler
Opens a window, in which the user names the Sampler track(s) before creating them. Options 
are: Name, how many tracks to create.

1

Signature Adds a Signature track, without further user input. 0
Tempo Adds a Tempo track, without further user input. 0

Transpose Adds a Transpose track, without further user input. 0

Using Track Preset… Opens a window, in which the user chooses the preset upon which the created will be based. 3

VCA Fader
Opens a window, in which the user names the VCA Fader track(s) before creating them. 
Options: Create inside a folder or outside a folder, name, how many tracks to create.

3

Video  Adds a Video track, without further user input. 0



Commands: Analyze

Spectrum Analyzer
Function: Brings up a Spectrum Analyzer window, when inside the Sample Editor (audio editor), 
or when an Audio Event is selected.

5 (available in Audio Menu, depends on frequency of 
usage)

Statistics
Function:  Brings up a Statistics window, when inside the Sample Editor (audio editor), or when 
an Audio Event is selected.

5 (available in Audio Menu, depends on frequency of 
usage)

Commands: Arranger
If you are working with the Arranger, it is 
worth it to create an extra keycommands 

Activate Activates Arranger Mode. 10 if working with Arranger

First Repeat Returns to the first repeat of the current arranger chain step. 4 if working with Arranger
 (You have an Arranger chain that 

comprises of A and B. A is to be repeated 
3 times, B 1 time. If at any time during 

Last Repeat Skips to the last repeat of the current arranger chain step. 4 if working with Arranger
(You have an Arranger chain that 

comprises of A and B. A is to be repeated 
3 times, B 1 time. If at any time during 

Next Chain Step Skips to the next step of the arranger chain. 4 if working with Arranger
(You have an Arranger chain that 

comprises of A and B. A is to be repeated 
3 times, B 1 time. If at any time during 

Previous Chain Step Skips to the previous step of the arranger chain. 4 if working with Arranger
(You have an Arranger chain that 

comprises of A and B. A is to be repeated 
3 times, B 1 time. If at any time during 

Trigger Arranger Event 1-20 Triggers the corresponding arranger event. 10 if working with Arranger
Commands: Audio

Adjust Fades to Range A  Adjusts the Fades of the event to the limits of the range. 10
If you have an audio event that starts at 1 

and ends at 9, but the "good part" is 
between 4 and 8, you take your range 

Auto-Grid Shift Q
In Sample Editor, under Definition, there exists Auto Adjust. That's what the key command 
does.

5+ depending on workflow

Bounce Selection
Bounces Selection. Works with range selection, perfect for making heavily cut, crossfaded, 
stitched parts, into a clean event again.

5+ depending on workflow

Close Gaps Time stretches the selected event so that it extends up to the next event. 5+ depending on workflow
We have an event that starts on 1, ends 
on 2. We have another event that starts 
on 6. If we select the first event and fire 

Close Gaps (Crossfade)

Not exactly sure. It seems that when using events that have been cut or resized, using this 
function closes the gaps by using parts from the whole audio file (before cutting or resizing the 
event) and applies a crossfade between the two events, if the original length of the file allows 
for it.

?

Constrain Delay Compensation Deactivates latency-inducing plugins. 2 (unless button not present on any toolbar)

Convert Tracks: Mono to Multi-
Channel

Brings up a window from which the user can convert tracks from mono to other multi-channel 
configurations.

4 (Found in Audio>Convert)

Convert Tracks: Multi-Channel to 
Mono

Brings up a window from which the user can convert tracks from multi-channel configurations 
to mono tracks.

4 (Found in Audio>Convert)



Create Sampler Track
Having selected an audio event, hitting the key command creates a sampler track with the 
selected event loaded into the sampler.

3 depending on workflow (last item in audio menu, 
easy to find)

Crossfade X Creates a crossfade between two audio events. 10
Decrement Event Volume Ctrl - Lowers volume of the selected event by 1dB. 5

Decrement Fade-In Length Moves fade in anchor to the left, in steps relatively proportional to the grid setting. 5

Decrement Fade-Out Length Moves fade out anchor to the right, in steps relatively proportional to the grid setting. 5

Delete Overlaps
When two or more events overlap, this command deletes what's underneath the overlapping 
area. Tip: If this command seems to delete part of the wrong event, You can use U to uncover 
the event that is being overlapped.

5+ depending

Detect Silence
Brings up the detect silence window, where we can easily chop up an event stripping silence in 
between program material.

6+ (hidden two-deep in Audio Menu)

Disable/Enable Track As it says. A toggle to disable/enable the selected track. 4- (easily accessible on right click menu)

Dissolve Part
When you select 4 audio events and glue them together, you get a part. This command allows 
you to dissolve the part, and go back to having 4 audio events.

5+ (Audio menu)

Event or Range as Region Creates Regions (available in the Sample Editor), from a selection of events, or a range. 6+ depending (under Audio>Advanced)

Events from Regions
When you have regions, and adjust their ranges, you can then select the original events 
(wherein the regions extend), and use this command to have the events change their lengths to 
what the regions dictate.

6+ depending (under Audio>Advanced)

Events to Part Makes a selection of events into a Part. (The opposite of dissolve part) 5+ (Audio menu)

Fade In to Cursor
When you have an audio event selected, this command will apply a fade-in that finishes at the 
position of the project cursor.

5+ (Audio menu)

Fade Out to Cursor
When you have an audio event selected, this command will apply a fade-out that starts at the 
position of the project cursor.

5+ (Audio menu)

Find Selected in Pool
As it says. You select an event, give the command, and then the Pool window pops up, with the 
respective file highlighted.

5+ (Audio menu)

Generate Harmony Voices… Auto-creates harmony voices. 5+ (Audio menu)
Increment Event Volume Ctrl = Raises volume of the selected event by 1dB. 5

Increment Fade-In Length Moves fade in anchor to the right, in steps relatively proportional to the grid setting. 5

Increment Fade-Out Length Moves fade out anchor to the left, in steps relatively proportional to the grid setting. 5

Invert Phase On/Off Flips the polarity of the selected event. 
7 depending (easily found second from last in Audio 
menu, but I find I use flip polarities in bursts, so…)

Note: This is not the channel PRE's flip 
phase button.

Minimize File
In pool, you can use this command to minimize the audio file to what the event shows. (The file 
itself may be longer, due to audio pre-record)

3 (in pool, right click on the file, then easily found in 
the menu OR in Media menu)

Notes: Minimize Audio is found in Media 
and not in Audio as expected.



Open Fade Editors
When you have an event that has fades applied to it, issuing the command will bring up the 
fade editors.

0 if used alone, 5 if used with Increment/Decrement 
Fade In/Out (It is not possible to enter new points 

with the keyboard in the Fade Editor)

Note: The fade editors open on top of 
each other. You see the fade-out editor, 
and then when you finish adjusting and 

close the window, the fade-in editor 
Remove Extension from Selected 

Events
Not sure. Probably removes ARA extensions from the selected events? ?

Remove Fades Removes fades from selected events 5+ depending

Remove Volume Curve
If you take your draw tool and draw on an event, you get a volume curve (or envelope). This 
command allows you to remove it.

3+ depending (third from last in Audio menu)

Set Definition From Tempo
Brings up the Set Definition From Tempo, window, in which you can apply the current Tempo 
to the event in the project, or the relevant file itself, and switch it to musical mode, so that you 
can then time stretch to Bars and Beats.

5+ depending (hidden two deep in Audio>Advanced)

Set Tempo From Event
Sets the global (project) tempo from a selected event. You need to use the locators to define 
the wanted length.

5+ depending (hidden two deep in Audio>Advanced)

Example: In a new project, record 9 claps. 
(in time. Any time) Crop the event so that 

it starts right at clap 1, and ends right 
before clap 9. We now have 2 measures 
of 4/4. Park the event to the start. Then 

Snap Point to Cursor
Issuing the command will move the Snap Point of the Event to where the project cursor 
currently is.

8+ depending (found in the middle of Audio menu)

Stretch to Project Tempo Stretches event to project Tempo 5+ depending (hidden two deep in Audio>Advanced)

To Origin Moves event to Origin (Note: Origin Time for the audio file can be found in the Pool window)
inf.(?) (cannot seem to find it anywhere in Cubase. 

Key command only?)

Update Origin Updates the event's Origin Time after you have moved it. 3+ (Found in Audio menu)
Origin Times take into account Audio Pre-
Record Seconds preference. If you have 1 

second pre-record, and you have a 4/4 

Commands: Audio Alignment

Add Selection as Alignment 
Reference

Uses the selected event as Alignment Reference. The Audio Alignment panel must be open. 8 if all alignment key commands are assigned.

Add Selection as Alignment 
Target

Uses the selected event(s) as Alignment Target(s). The Audio Alignment panel must be open. 8 if all alignment key commands are assigned.

Align Audio
Performs the actual Alignment, after the reference and targets have been set. The Audio 
Alignment panel must be open.

8 if all alignment key commands are assigned.

Open Audio Alignment Panel
Opens and closes the Audio Alignment Panel. The Audio Alignment panel must be open (just 
kidding)

8 if all alignment key commands are assigned.

Remove Alignment Reference If an alignment reference has already been assigned, you can remove it with this command. 8 if all alignment key commands are assigned.

Remove All Alignment Targets
If alignment targets have already been assigned, you can remove all of them at once with this 
command.

8 if all alignment key commands are assigned.



Commands: Audio Export
Tip: To get the most out of those 

keycommands, you should also assign 
Commands>File>Export Audio Mixdown, 

Increase Counter Start Value
In Export Audio Mixdown, you can apply naming schemes. One of the options is to have a 
counter (e.g. Audio 01-001, Audio 01-002, Audio 01-003). This command increases the counter 
start value from the main Export Audio Mixdown window.

2

Perform Audio Export Presses the button Export Audio, when the Export Audio Mixdown window is open. 0 (unless on resolution less than 1920x1080 ?)

Reset Counter Start Value
In Export Audio Mixdown, you can apply naming schemes. One of the options is to have a 
counter (e.g. Audio 01-001, Audio 01-002, Audio 01-003). This command resets the counter 
start value from the main Export Audio Mixdown window.

2

Sync Channel Selection with 
MixConsole

Select some channels in your MixConsole. Then open up Export Audio Mixdown. Issuing this 
command will tick (for export) the channels you have selected in the MixConsole.

6

Commands: Audio Realtime 
Processing

Create Warp Markers from 
Hitpoints.

What it says. Creates Warp Markers from Hitpoints

4 (Works directly on selected event (provided that 
preference Automatic Hitpoint Detection is ticked). 

The command itself is easily found in the Sample 
Editor>Hitpoints>Create Warp Markers from 

Hitpoints)

Flatten Realtime Processing
What it says. Takes your (Audio File + processing) and makes it into a (new processed audio 
file), ready for a new round of processing, if you wish. User input is required, in choosing the 
algorithm that will be used.

4

Unstretch Audio What it says. If an audio event has been stretched, this command unstretches it. 6

Commands: Automation
Notes: Most of the key commands for 

automation, especially the 8+8 read/write 
suspend buttons, are invaluable if used 

Automation Mode - Auto-Latch Switches to Auto-Latch mode 7

Automation Mode - Cross-Over Switches to Cross-Over mode 7

Automation Mode - Touch Switches to Touch mode 7
Automation Mode - Trim Activates/Deactivates Trim mode 7

Delete All Automation in Project What it says
0 (10 if you are sure you don't accidentally hit it. 

Because it runs instantly, no confirmation required.)

Delete Automation in Range What it says 10
Delete Automation of Selected 

Tracks
What it says

5 (Again, caution is advised, no confirmation 
required)



Fill Gaps
Cycles through Enable, Lock, Disable of the "Fill Gaps" button of the Automation Panel. 
Enabling it allows the gaps to be auto-filled as you draw new automation segments (or 
touch/move/release, retouch faders).

5+

Fill Gaps on Selected Tracks
THIS is the key command that fills gaps between automation segments. It acts instantly, and on 
a selection of one or more tracks. 

8+

Fill Gaps with Current Value 
(Selected Tracks)

This key command instantly fills gaps between automation segments on all selected tracks with 
the Current Value. Tip: If there is truly a gap under the cursor, you can change what the current 
value is, directly from the Automation lane (or faders). You set each lane or fader to the 
desired value, and then issue the key command. Observe how gaps have been filled with each 
lane's selected value.

8+

Fill Loop

Cycles between On/Lock/Disable for the "Fill" button of the Automation Panel. When active, 
you touch a fader, adjust until you have the desired level and you let go. What happens is that 
the value grabbed when you let go of the fader will fill the loop (between the left and right 
locators).

5+

Fill To End
Cycles between On/Lock/Disable for the "To End" button of the Automation Panel. When 
active, you touch a fader, adjust until you have the desired level and you let go. What happens 
is that the value grabbed when you let go of the fader will fill the lane to the end of the project.

5+

Fill To Punch

Cycles between On/Lock/Disable for the "To Punch" button of the Automation Panel. When 
active, you touch a fader, adjust until you have the desired level and you let go. What happens 
is that the value grabbed when you let go of the fader will fill the lane back in time to the 
moment where you first grabbed the fader.

5+

Fill To Start

Cycles between On/Lock/Disable for the "To Start" button of the Automation Panel. When 
active, you touch a fader, adjust until you have the desired level and you let go. What happens 
is that the value grabbed when you let go of the fader will fill the lane back to the start of the 
project.

5+

Freeze All Trim Automation in 
Project

This is like flatten processing for automation. When we have an automation pass and a trim 
pass, their sum is depicted as a third line. Upon issuing this command, this "third line" becomes 
the NEW actual automation, and trims are reset to zero. For the whole project.

3+ depending (much higher if using trim extensively)

Freeze Trim Automation of 
Selected Tracks

 This is like flatten processing for automation. When we have an automation pass and a trim 
pass, their sum is depicted as a third line. Upon issuing this command, this "third line" becomes 
the NEW actual automation, and trims are reset to zero. For the Selected Tracks.

3+ depending (much higher if using trim extensively)

Hide All Automation Hides all automation lanes. 10
Hide Automation Hides automation lanes of the selected track(s). 10

Next Automation Mode Cycles through Touch, Auto-Latch, Crossover modes.
7 (matter of preference, there exist separate 

commands for each mode too)
Open Panel F6 Brings up the Automation Panel 10

Punch Out of Latch Automation
When in Auto-Latch Mode, you can manually punch out of the automation pass with this 
command.

7



Read Automation for All Tracks 
On/Off

Alt R
Global enable/disable read button for all Track Automation. Note: This command is like 
pressing the R button in the Automation Panel

10

Read Automation for Selected 
Tracks On/Off

What it says. 5+

Show All - Used Only

This key command toggles the Used Only option at the bottom right of the Automation Panel. 
When unticked, the buttons above (Volume, Pan, EQ, Dynamics, Sends, Inserts, Show Used) 
will show the relevant automation lanes, whether they contain data or not. When ticked, the 
buttons will only show the relevant automation lanes that contain data.

6+

Show All EQ Automation
This key command shows EQ automation lanes for all tracks, and cycles through the 4 bands. If 
Used Only is ticked, it will show just the lanes with EQ automation data on them.

6+

Show All Insert Automation
This key command shows Insert automation lanes for all tracks, and cycles through the insert 
plugins' parameters. If Used Only is ticked, it will show just the lanes with Insert automation 
data on them.

6+

Show All Pan Automation
This key command shows Pan automation lanes for all tracks, and cycles through the two 
channel pans, and the 8 sends pans. If Used Only is ticked, it will show just the lanes with Pan 
automation data on them.

6+

Show All Send Automation
This key command shows Sends automation lanes for all tracks, and cycles through the eight 
sends. If Used Only is ticked, it will show just the lanes with Send automation data on them.

6+

Show All  Used Automation
This key command shows all used automation lanes for all tracks. I don't think Used Only 
affects this command in any way.

10

Show All Volume Automation
This key command show Volume automation lanes for all tracks. If Used Only is ticked, it will 
show just the lanes with Volume automation data on them.

6+

Show Automation
This key command expands the automation lanes of the selected tracks. It does the same job 
as clicking to the semi-hidden button on the bottom left of a track header, just under the 
symbol for each track type. (e.g. the squiggly wave for audio tracks)

8 (if paired with Hide All Automation)

Show Used Automation (Selected 
Tracks)

This key command shows all of the selected track's (or tracks') automation lanes that contain 
data.

8 (if paired with Hide All Automation)

Suspend Reading All This toggle key command will turn automation read on and off. 7
Suspend Reading Dynamics, EQ, 

Inserts, Mute, Others, Pan, 
Sends, Volume

These 8 commands suspend read of the corresponding automation data. 4

Suspend Reading/Writing All What it says. The A button next to R W in the Automation Panel. 10
Suspend Writing All What it says. Will only read automation, will not allow writing automation. 4

Suspend Writing Dynamics, EQ, 
Inserts, Mute, Others, Pan, 

Sends, Volume
These 8 commands suspend write to the corresponding automation data. 4

Use Virgin Territories Toggles the usage of Virgin Territories on and off. 4



Write Automation for All Tracks 
On/Off

Alt W Disables automation write for all tracks. 10

Write Automation for Selected 
Tracks On/Off

Disables automation write for the selected track(s). 8

Commands: Beat Designer 

All commands control the MIDI Insert 
Plug-in "Beat Designer", and allow 

transforming Beat Designer's patterns 
into MIDI parts. 

Fill Loop with Pattern
If you have a pattern ready in the Beat Designer, this command will paste the pattern to the 
midi track over and over until it fills the space between the left and right locators.

5+

Insert Pattern at Cursor As it says. Inserts the pattern at the cursor's position. 5+
Insert Pattern at Left Locator As it says. Inserts the pattern at the Left Locator. 5+

Insert Subbank at Cursor

Those button labels called "1", "2", "3" and "4" over the piano keys are subbanks. Each subbank 
can contain up to 12 patterns, on each piano key. When you give this command, the patterns 
contained within the pattern will be pasted one after the other at the cursor's position. Note: If 
you have 3 patterns, one on key C, one on key F, one on Key Bb, they will still be pasted one 
after the other, with no gap between them.

5+

Insert Subbank at Left Locator

Those button labels called "1", "2", "3" and "4" over the piano keys are subbanks. Each subbank 
can contain up to 12 patterns, on each piano key. When you give this command, the patterns 
contained within the pattern will be pasted one after the other at the left locator. Note: If you 
have 3 patterns, one on key C, one on key F, one on Key Bb, they will still be pasted one after 
the other, with no gap between them.

5+

Commands: Channel & Track 
Visibility

Notes: Activating Sync Project and 
MixConsole will allow visibility changes 
done to the mixer apply to the project, 
and vice versa. This is very important, 
because some visibility agents that are 

otherwise exclusive to the project 
window OR the mixconsole, become 

readily available for both!

Tip: If working with Sync Project & 
MixConsole, I find it better to make 
configurations "native" to the target 
window. For example, in the project 

window I wouldn't waste a configuration 
that would show me just channels 1, 4, 6, 

Agents: Hide Muted Tracks Hides muted tracks. 8



Agents: Hide Selected 
Channels/Tracks

As it says. 8

Agents: Redo Visibility Change
As it says. Tip: If you apply a visibility change, it's faster to change between the before/after 
states by undoing/redoing visibility changes than applying different agents.

9

Agents: Show All 
Channels/Tracks

As it says.
5+10 depending (easily accessible both in the project 

window and the mixconsole)

Agents: Show Channels that are 
Connected to the First Selected 

Channel

Shows all the channels that are connected to the first selected channel. A powerful agent. 
Example: If you select an effects return channel and give the command, all channels will vanish 
except those that are connected to the effect return in any way, be it direct routing or sends. 
Then use visibility undo to return to the previous visibility status.

10

Agents: Show Channels/Tracks 
with Data

As it says. Shows only Channels/Tracks that contain data. Every other channel/track is hidden 
from view. Note: An empty midi part still counts as data.

5+ depending (easily accessible both in the project 
window and the mixconsole)

Agents: Show Channels/Tracks 
with Data at the Cursor Position

As it says. Shows only Channels/Tracks that contain data at the cursor's position. Every other 
channel/track is hidden from view. Note: An empty midi part still counts as data.

5+ depending (easily accessible both in the project 
window and the mixconsole)

Agents: Show Channels/Tracks 
with Data between the Locators

As it says. Shows only Channels/Tracks that contain data between the Locators. Every other 
channel/track is hidden from view. Note: An empty midi part still counts as data.

5+ depending (easily accessible both in the project 
window and the mixconsole)

Agents: Show Only Selected 
Channels/Tracks

As it says.
8+ depending (easily accessible both in the project 

window and the mixconsole)
Agents: Show Tracks with 

Selected Events
As it says. When you have selected a bunch of events and give the command, only the tracks 
with the selected events will be shown, all others will be hidden.

8+ depending (easily accessible in the project 
window)

Agents: Undo Visibility Change
As it says. If you have applied a visibility agent and you give the command, it takes you back to 
the previous visibility status.

10

Create Visibility Configuration

Creates a new visibility Configuration. Note & Tip: The command is common for both the 
project window, and the mixconsole. However, the window that has focus will receive the 
command, and the resulting visibility configuration will be for that window. But, with Sync 
Project & Mixconsole Visibility enabled, and some careful focus shifts, we can double the 
visibility configurations to 16.

9 depending (if not fan of Sync Project & MixConsole, 
avoid!)

Example: Focus to the project window. 
Activate Sync Project & Mixconsole. 

Manually hide some channels from the 
visibility tab. Then give the command. 
Name the configuration "1". Observe, 

that visibility configuration "1" is available 
for the project window. Now switch to 
the mixconsole and observe that the 

visibility configuration has been applied! 

Sync Visibility of Project and 
MixConsole: On/Off

This command will switch on and off the synchronization between the visibility of the Project 
window and the MixConsole. While this is on, any visibility changes made on the project 
window will apply to the mixconsole, and vice versa.

2 (easily accessible, project window must have focus 
for the command to work)



Update Visibility Configuration

This command will "save", and overwrite your currently selected visibility configuration. 
Disambiguation: Load a configuration, and then make some changes (e.g. Hide some channels). 
Notice the asterisk next to the number. This means the configuration has been changed from 
what it is. If you wish to save those changes to your configuration, give the command. Your 
configuration will now be updated to include the changes, and the asterisk will be gone.

7+ (caution is advised, works instantly, and the 
command is common for both the project and the 

mixconsole  depending on which window has focus)

Visibility Configuration 1-8 Ctrl Alt 1-4 Instantly recalls the configuration with the corresponding number from 1 to 8.
10 (remember that the window that has focus 

receives the command, be it the project window or 
the mixconsole window)

Commands: Channel Settings

Notes: It is sad that channel settings do 
not have any more key commands. Even a 

simple "Insert Effect on Next Free Slot", 
or "Activate Send 1-8" would go a long 
way. No way to control even the pre 

section, no way to even push the "phase" 
button. This section definitely needs some 

love.

Observation: The window is divided in 
three zones. Tab will switch focus to the 

first element of each zone. However, 
Show Next Tab/Show Previous Tab 

commands do not work in this window, 
making it impossible to switch from 
Inserts to Strip in the left zone, for 

Show/Hide Direct Routing As it says. Shows/Hides the side panel that contains the direct outputs routing.
0 (easily accessible in Set up Window Layout of the 

Channel Settings window)

Show/Hide Output Chain
As it says. Shows/Hides the chain of outputs. If the channel goes through a group 1, and then 
this group 1 goes to group A, and then group A goes to the Master, it will reveal those 3 faders; 
group 1, group A, Master.

0 (easily accessible in Set up Window Layout of the 
Channel Settings window)

Chords

Assign Voices to Notes
When you select a chord, this command will assign voices to the notes, depending on the 
number of voices.

5 (Project > Chord Track)

Example: Insert four notes in the Key 
Editor. Select them. Give the command. 
Notice how each note has been assigned 

a voice when you select them: Bass, 
Tenor, Alto, Soprano.

Note: This command will also work for 
arpeggios. (This means that if you insert 
four notes, C3 at 1.1,E3 at 1.2, G3 at 1.3, 
and C4 at 1.4, and then select them and 

give the command, they will still get Bass, 



Chord Editing - Add to Chord 
Track

When you select a chord, this command will create a Chord Track (if it doesn't exist yet) and 
add the chord to the Chord Track.

3 (easily accessible from Chord Editing inspector 
panel)

Note: Any selection of notes with work 
with the command, and the resulting 

voicing will be the sum of this selection.

Example: Insert two chords. At 1.1 have 
C3, E3, G3, B3. At 1.3 have D3, F3, A3. 

Then select the first chord and give the 

Chord Editing - Drop 2
When you select a chord and give this command, the note second from the top will be 
transposed one octave down.

3 (easily accessible from Chord Editing inspector 
panel)

Chord Editing - Drop 2 and 4
When you select a chord and give this command, the note second from the top, and the note 
fourth from the top, will be transposed one octave down.

3 (easily accessible from Chord Editing inspector 
panel)

Chord Editing - Drop 3
When you select a chord and give this command, the note third from the top will be 
transposed one octave down.

3 (easily accessible from Chord Editing inspector 
panel)

Chord Editing - Inversions: Move 
Down

When you select a chord and give this command, the top note will be transposed one octave 
down.

3 (easily accessible from Chord Editing inspector 
panel)

Note: A bit misleading the name of this 
key command. I thought move down 

would take me from a 2nd inversion to 
1st inversion, automatically bringing the 
3rd of the chord to the bass (and sending 

up the 5th from the bass to the inner 
voices). The correct description is in the 
tooltip of the command, at Inspector's 

Chord Editing > Inversions. "Move 
highest note to bottom".

Chord Editing - Inversions: Move 
Up

When you select a chord and give this command, the bottom note will be transposed one 
octave up.

3 (easily accessible from Chord Editing inspector 
panel)

Note: A bit misleading the name of this 
key command. I thought move up would 

take me from a 1st inversion to 2nd 
inversion, automatically bringing the 5th 
of the chord to the bass (and sending up 

the 3rd from the bass to the inner voices). 
The correct description is in the tooltip of 

the command, at Inspector's Chord 
Editing > Inversions. "Move lowest note 

to top".

Chord Editing - Match with Chord 
Track

When you select a chord and give this command, it will be transformed to match the voicing 
shown at the Chord Track

3 (easily accessible from Chord Editing inspector 
panel)

Note: This command doesn't seem to 
work with multiple chords.

Example: We have a chord track with one 
chord per bar. The chords are: Cmaj7, 
Fmaj7, Dmin7, G7. If we draw one four 

Chord Pads Setup… Brings up the Chord Pads setup window.
5 (two clicks from the Lower Zone Tabs, or in Project 

> Chord Pads)



Chords to MIDI
When you have a track selected (Instrument, MIDI), giving this command will realize the chord 
track. Plainly said, it will create a midi part, and fill it with the right notes, as defined in the 
Chord Track. Chord Track says Cmaj7, midi track will have C, E, G, B.

5 (In Project > Chord Track)

Note: Works from project window, when 
a track (MIDI, Instrument) is selected.

When used, the track will have its "Follow 
Chord Track" enabled and switched to 

Create Chord Symbols This command will detect the chords of the selected tracks, and insert them to the Chord Track 5 (In Project > Chord Track)

Note: This command works according to 
selection. If you have a track with Am, G, 

select it and give the command, the 
Chord Track will then have exactly Am, G. 

Map to Chord Track
This command will match a selection of parts or events to the Chord Track.

5 (In Project > Chord Track)

Show/Hide Chord Pads Ctrl Shift C This command will show/hide the Chord Pads section in the Lower Zone 5 (In Project > Chord Pads)

Control Room
Tip: Make sure you double check your 
Control Room configuration in Audio 

Connections (F4). If something seems to 

AFL/PFL This command will switch AFL/PFL for the "Main" LISTEN 5
Note: This is the command that presses 
the button that exists in Control Room 

Click On/Off This command will switch the metronome's click On/Off for the "Main" 5

Control Room On/Off Activates/Deactivates the "Main" Channel of the Control Room 5
Note: From the wording, this command 

might seem like it would 
activate/deactivate the control room like 

Cue 1 On/Off Activates/Deactivates Cue 1 5
Cue 2 On/Off Activates/Deactivates Cue 2 5
Cue 3 On/Off Activates/Deactivates Cue 3 5
Cue 4 On/Off Activates/Deactivates Cue 4 5

Deactivate All Listen States
What it says. If you have many channels in Listen mode in your mixconole, this command will 
deactivate them all.

8

Dim Signal On/Off What it says. Enables the dimming of signal for the "Main" section. 5 Note: The Main Dim Volume is found in 
Enable/Disable Listen for Output 

(LE)
What it says. Enables/Disables Listen for the "Main" section 5

Phones Channel On/Off What it says. 5
Reference Level On/Off What it says. Uses the reference level for the "Main" 5

Select Control Room Source This command will cycle the "Main" section's sources, from Monitor Mix, to Cues 1, 2, 3, 4 5

Select Downmix Preset 1 What it says. 5
Select Downmix Preset 2 What it says. 5
Select Downmix Preset 3 What it says. 5
Select Downmix Preset 4 What it says. 5

Select Monitor 1 What it says. 5
Select Monitor 2 What it says. 5
Select Monitor 3 What it says. 5
Select Monitor 4 What it says. 5



Select Next Downmix Preset What it says. 5
Select Next Monitor What it says. 5
Speaker Solo: Cancel What it says. 5
Speaker Solo: Center What it says. 5
Speaker Solo: Front What it says. 5
Speaker Solo: Left What it says. 5

Speaker Solo: Left of Center What it says. 5
Speaker Solo: Left - Right What it says. 5

Speaker Solo: LFE What it says. 5
Speaker Solo: Rear What it says. 5

Speaker Solo: Rear to Front What it says. 5
Speaker Solo: Right What it says. 5

Speaker Solo: Right of Center What it says. 5

Speaker Solo: Side What it says. 5
Speaker Solo: Side Left What it says. 5

Speaker Solo: Side Right What it says. 5
Speaker Solo: Solo to Center What it says. 5
Speaker Solo: Surround Left What it says. 5

Speaker Solo: Surround Right What it says. 5
Speaker Solo: Top Side Left What it says. 5

Speaker Solo: Top Side Right What it says. 5
Talkbalk On/Off What it says. 5
Devices (Studio)

Audio Connections F4 This commands opens the Audio Connections window. 10
Audio Performance F12 Brings up the Audio Performance window 10

Control Room Brings up the Control Room window 0-10
We have the Right Zone for that, but for 

people that prefer floating windows, I 

Generic Remote Brings up the Generic Remote Panel, from where we can manually change banks. 0-10

If there are enough buttons on the 
controller, 0. But I can imagine 
circumstances when it could be 

invaluable.

Mackie Control
Brings up the Mackie Control Panel, from where we can choose between Cubase and 
Compatibility modes.

0
Note: This command might not exist if 

there is currently no Mackie Control set 
up. Keyworthiness score is 0 because 

Max. Record Time Brings up a window, in which the maximum recording time is displayed in big numbers. 3
Note: Time shown depends on the 

current recording settings. If we change 
MIDI Device Manager Brings up the MIDI Device manager. 0

MixConsole F3 Brings up the MixConsole 10
MixConsole 2 Brings up MixConsole number 2 10 depending
MixConsole 3 Brings up MixConsole number 3 10 depending



MixConsole in Project Window Alt F3 Brings up the Lower Zone Mixconsole, in the project window 10

MMC Master Panel Brings up the MMC panel 0-10 depending

On-Screen Keyboard Alt K Brings up a small on-screen piano keyboard. 8 for emergencies
Note: There is a little dot that extends the 
keyboard and allows the lower row of the 

Show Panel Brings up a side panel which contains shortcuts for most of the devices in the Studio menu 4 depending

System Component Information Brings up a panel which lists Cubase's system compenents. 0

Time Display Brings up a window which shows the project's Primary Time Display in HUGE numbers. 4 depending

Video Player F8 Brings up the Video Player 10
VST Instruments F11 Brings up the VST Instruments Rack 10

VST Plug-in Manager Brings up the VST Plug-in Manager 4 depending

Direct Offline Processing
If working extensively with DOP, maybe 

it's worth it to assign a key command 

Add Plug-in
Adds a plug-in. Actually opens the plug-ins window and parks the cursor in the search field, 
ready to search for the plug-in to add.

7

Add Process
Adds a process. Actually opens the processes window and parks the cursor in the search field, 
ready to search for the process to add. 

7

Bank 1 Switches over to the 1st bank of Favorites 7
Bank 2 Switches over to the 2nd bank of Favorites 7
Bank 3 Switches over to the 3rd bank of Favorites 7
Bank 4 Switches over to the 4th bank of Favorites 7

Bypass Selected Process Bypasses the selected Process 7
Note: Does not seem to work for me. I 

think this key command presses the little 
Direct Offline Processing F7 Brings up the Direct Offline Processing panel 10

Discard Discards changes to the currently selected process 7
Note: Does not seem to work for me. I 

think this key command presses the 

Favorite 1 Inserts the process chain stored in Favorite 1 to the process list. 7
Note: Does not seem to work for me. I 
think this key command clicks on the 

Favorite 2 Inserts the process chain stored in Favorite 2 to the process list. 7
Note: Does not seem to work for me. I 
think this key command clicks on the 

Favorite 3 Inserts the process chain stored in Favorite 3 to the process list. 7
Note: Does not seem to work for me. I 
think this key command clicks on the 

Favorite 4 Inserts the process chain stored in Favorite 4 to the process list. 7
Note: Does not seem to work for me. I 
think this key command clicks on the 

Favorite 5 Inserts the process chain stored in Favorite 5 to the process list. 7
Note: Does not seem to work for me. I 
think this key command clicks on the 

Favorite 6 Inserts the process chain stored in Favorite 6 to the process list. 7
Note: Does not seem to work for me. I 
think this key command clicks on the 



Favorite 7 Inserts the process chain stored in Favorite 7 to the process list. 7
Note: Does not seem to work for me. I 
think this key command clicks on the 

Favorite 8 Inserts the process chain stored in Favorite 8 to the process list. 7
Note: Does not seem to work for me. I 
think this key command clicks on the 

Favorite 9 Inserts the process chain stored in Favorite 9 to the process list. 7
Note: Does not seem to work for me. I 
think this key command clicks on the 

Make All Permanent Makes the selected Direct Offline Process permanent, baking them to the file. 7 Note: Alas, it does nothing for me here.
Toggle Auto Apply Toggles Auto Apply mode 7 Note: Alas, it does nothing for me here.

Edit

Acoustic Feedback On/Off
Toggles Acoustic Feedback On/Off. When on, selecting or inserting a single event will make 
sound. When off, the instrument will not play when you insert new notes, or select them. It will 
only make a sound when you press play from the transport

3

Activate Next Part

When you have multiple Parts selected, all are visible in the editor, but the active part, the one 
that is being edited, is in the foreground, while the inactive ones stay grayed out in the 
background. This command will allow you to activate the next part, and bring it to the 
foreground.

7

Activate Previous Part

When you have multiple Parts selected, all are visible in the editor, but the active part, the one 
that is being edited, is in the foreground, while the inactive ones stay grayed out in the 
background. This command will allow you to activate the previous part, and bring it to the 
foreground.

7

Activate/Deactivate Focused 
Object

Alt A
Multifunctional key. Activates/Deactivates whatever can be activated/deactivated when it's 
focused.

10
Note: Works on headers (Inserts, Sends, 

EQ, Strip) to bypass them. Works on 
specific controls that have focus, e.g. an 

Apply Click Pattern to Equal 
Signatures

This command will apply your click pattern to the same signature. If you have many instances 
of the same time signature (e.g. 3/4, you can modify the click for one of those 3/4 changes, and 
then give the command to have the click pattern apply to all 3/4 changes.

7 easily accessible from the Signature Track's arrow 
button

Auto Select Events under Cursor
When you give this command, the Preference Auto Select  Events under Cursor is 
Activated/Deactivated. This command will not select events by itself.

4
Note: This is a preference switch 

command, not a select events command.
Auto-Scroll On/Off F Activates/Deactivates automatic scroll of the project window. 10

Automation Follows Events
Activates/Deactivates the preference Automation Follows Events. When Activated, if you move 
an event around, its automation (if it exists) will follow the event around too.

4
Note: This is a preference switch 

command.

Clean Up Lanes
This command will re-arrange events on lanes and remove lanes, so that that the minimum 
required amount of lanes are kept for the events on a lane not to overlap.

5 (found by right clicking on audio track)

Click Pattern to Default
This command will remove all custom metronome patterns, and reset them to the default 
patterns.

3 (found in Signature Track's arrow menu)
Note: In Signature Track's arrow menu, it 

is Reset Click Patterns to Default.

Convert to Real Copy When we have a shared copy selected, this command will convert it to a Real Copy. 5 (Found in Edit > Functions)
Note: The name of the command could 
be "Convert Shared Copy to Real Copy" 

Copy Ctrl C Copies! 10



Copy A <-> B Setting Copies setting A to setting B, and copies setting B to setting A. 3 Only works for Channel Settings > 

Copy Click Pattern to Clipboard
As it says. Copies the Click Pattern to Clipboard, so that later you can Paste to Selected 
Signatures

3 (Found in the Signature Track's arrow menu)

Create Tracks from Lanes As it says. Creates tracks from the existing lanes of an audio track. 3 (found by right clicking on an audio track)
Crop Range Crops the events to the selected range. 10 (I love it)

Cut Ctrl X Removes selection, copies it to the clipboard for later pasting. 10

Cut Head
Select part of an event with the range tool. Give the command. Observe how "the head" 
(what's left of the starting point of the range) is removed.

10 (a good command)
This isn't a Cut and then paste command. 
It's actually a macro that Splits at the start 

Cut Tail
Select part of an event with the range tool. Give the command. Observe how "the tail" (what's 
right of the ending point of the range) is removed.

10 (a good command)
This isn't a Cut and then paste command. 
It's actually a macro that Splits at the end 

Cut Time Ctrl Shift X

This command will cut (with the option to paste later) pure time. For example: If you have 
events ranging from 1.1.1.0 to 32.1.1.0 and you make a range selection from 9.1.1.0 to 17.1.1.0 
and then give the command, you'll see how the contents of the range are gone, and what at 
first started at 17.1.1.0 has now been moved to 9.1.1.0. It's as if time... has been cut.

10

Deactivate All Mute States This command deactivates all pressed mute buttons 4 (easily found on the toolbar, as State Buttons)
This command will not work on 

Automation mutes.

Deactivate All Solo States This command deactivates all pressed solo buttons 4 (easily found on the toolbar, as State Buttons)

Delete Del ; Backspace Deletes 10

Delete Time Shift Backspace
Deletes Time. Select a range. Issue the command. See how everything to the right of the end of 
the range has been moved to the start of the range.

10
If you want to Paste this Time afterwards, 

use Cut Time (Ctrl Shift X)

Duplicate Ctrl D Duplicates the current selection by copying and pasting at the end of the whole selection. 10

Edit Active Part Only

When we have many parts selected and we open an editor, all those parts will show in the 
editor. The active part is in the foreground, the rest in the background. However, if we click 
purposefully on an event in the background, the part that contains this event becomes active. If 
you don't like this behavior, use this command so that you edit the active part only.

4 (easily available on the editor's toolbar)

Edit Channel Settings Alt Shift E Brings up the Channel Settings window 10

Edit Info Line
Double clicks on the first field on the Info Line, and readies the cursor for immediate keyboard 
input. Hop between fields with Tab and Shift Tab

5 depending
You can cycle through the fields with Tab, 
but not with Shift Tab. Tab will return to 

the first field after having reached the 

Edit VST Instrument Brings up the connected VST instrument's GUI. 5 depending
Works for midi channels too! As long as 

the output of the midi track is connected 

Enlarge Range to Next Event
Enlarges Range to Next Event. If you experience weird selection choices, that is because you 
have a track selected, and the range is being enlarged up to the next event in THAT track.

7 depending

Enlarge Range to Previous Event
Enlarges Range to Previous Event. If you experience weird selection choices, that is because 
you have a track selected, and the range is being enlarge up to the previous event in THAT 
track.

7 depending



Enlarge Selected Track
Activates/Deactivates Preference Enlarge Selected Track. When Active, the currently selected 
track will be bigger than the others.

1 (not for constant use) This is a Preference

Equal Pitch - all Octaves
Select a note, say a D. Give the command. Observe how all Ds have been selected, in all 
octaves.

5 (In Edit > Select)

Equal Pitch - same Octave
Select a note, say a D. Give the command. Observe how all Ds have been selected, in the same 
octave.

2 (In Edit > Select)
You can Ctrl Click a key on the vertical 

keyboard of the Key Editor and achieve 

Expand/Reduce Alt E Expands/Reduces the racks of the Mixconsole 0
Getting the focus to where you want it 
with a keyboard is semi-impossible, so 

Fill Loop
Make a selection of parts(midi) and events(audio). Set a Loop (Left Locator to 9, right locator to 
17). Give the command. Observe how the loop is neatly filled with the events/parts.

8

Find Track/Channel Ctrl F Brings up a search list so that you can find channels 10
Global Copy Copies everything between the left and right locator. 8

Glue Does like the glue tool. 2
This is NOT the tool, this is the action 
performed by the tool. It is instant. It 

Grid Type: Adapt to Zoom Switches the project window's  grid type to "Adapt to Zoom" 7 Works for the key editor too. Mind which 
Grid Type: Bar Switches the project window's grid type to "Bar" 4

Grid Type: Beat Switches the project window's grid type to "Beat" 4
Grid Type: Use Quantize Switches the project window's grid type to "Use Quantize" 7 Works for the key editor too. Mind which 

Group Ctrl G
Groups the selected parts/events together. From then on, whatever you do on one of them 
applies to all of them. Select one, all are selected. Adjust a fade, all get the same fade. Split 
one, all split.

10
A symbol appears on the parts/events 

that are grouped.

Group Editing on Selected Tracks 
On/Off

K Activates/Deactivates Group Editing on the selected Folder track. 10
Folder should be mentioned in the name 

of the command for clarity.
History Brings up the Undo/Redo History window 5 depending

Insert Bars Brings up the Process Bars Panel, in which we can insert, delete, reinterpret and replace bars 5 (found in Project > Signature Track)

Insert Silence Ctrl Shift E Inserts silence at the defined range. 10
INSERTS silence. Any events caught in the 

range will be moved to after the end of 
Invert Alt F Nothing 0 Invert selection is what it should be. See 

Invert Selection
Inverts selection. Select something, give the command, everything else will be selected, except 
the things you had selected first.

10
Edit > Select > Invert is the function. A key 

command is assigned to "Invert" (Alt F). 
This however does nothing. On the other 

Key Commands Opens up the Key Commands window 10 (I have it assigned to Shift F12)
Left Selection Side to Cursor E As it says. Makes the left side of the range go to where the cursor currently is. 10

Listen Pushes listen on selected track. 8
Lock Ctrl Shift L Locks selected event/part. 10

Lock/Unlock Track Locks /Unlocks selected track(s) 5 depending Should include the (s) in the name to 
Monitor Ctrl Alt M Activates/Deactivates monitor for the selected track(s) 10

Move Insert Cursor To Part Start
When Step Input is enabled in Key/Score Editor, a blue line appears. That's the Insert Cursor. 
Giving this command will return that cursor to the start of the part.

5 depending



Move to Back When events overlap, you can push the overlapping event to the back with this command. 7 depending

Move to Cursor Ctrl L This command moves the selected event to the Cursor's position. 10 Audio events will have their snap point 

Move to Front (Uncover) U When events overlap, you can bring the overlapped event to the front with this command. 10

Move to Selected Track This command will move selected events to the selected tracks. 2 depending
Mute M Presses the Mute button on all selected tracks. 10

Mute Events Shift M Mutes Selected events. 10

Mute/Unmute Objects Alt M Mutes/Unmutes Selected objects 10
Mute Events, Unmute Events, and 

Mute/Unmute Objects seem to be the 
Open Ctrl E Opens the editor for the selection. 10? I can't seem to find any differences with 

Open Device Panel Opens the Device Panel for the selected track. 5 depending (easily available on Inspector)
Paste Ctrl V Pastes! 10

Paste at Origin Alt V Pastes audio files at the time of their origin 10
Paste Click Pattern to Selected 

Signatures
After you copy a click pattern, you can paste it to a selection of signatures.

5 (easily done from the Signature Track's arrow 
menu)

Paste Relative to Cursor Shift V

This command will paste to a position relative to the cursor. Example: You have an event from 
1 to 3. Select it. Your cursor is at 5. Ctrl C to copy. Then move your cursor to 11. Press Shift V. 
See how the event is pasted from 7-9, preserving the offset the cursor had at the time of 
copying.

10

Paste Time Ctrl Shift V After you have Cut Time (Ctrl Shift X), you can then paste it with this command. 10

Paste Time at Origin
After you have Cut Time (Ctrl Shift X), you can then paste it with this command, at the Origin of 
the selected event.

5 depending

Paste to Matching Track Name
Pastes (at the cursor's position or at the start of a defined range) to a track with the same 
name. The name is taken from the original track at the time of copy.

4 depending

Preferences Takes you to preferences 7 depending

Primary Parameter: Decrease Ctrl Shift Down
This command lowers the volume of the focused channel(s) in 1dB steps. Works in Mixconsole 
only.

5

If you want to change the volume of 
many adjacent channels:

First get focus on the first channel. Then 
expand the selection using  the key 

command "Project>Select Track:Add 
Next/Prev". Then Q-link the channels and 

give the command. That should do it.
Primary Parameter: Fine 

Decrease
This command lowers the volume of the focused channel(s) in 0.1dB steps. Works in 
Mixconsole only.

5 See above.

Primary Parameter: Fine Increase
This command raises the volume of the focused channel(s) in 0.1dB steps. Works in Mixconsole 
only.

5 See above.

Primary Parameter: Increase Ctrl Shift Up
This command raises the volume of the focused channel(s) in 1dB steps. Works in Mixconsole 
only.

5 See above.

Process Tempo This command brings up the process tempo panel. 7 (found in Tempo Track) If you want this command to work from 
Profile Manger… This command brings up the Profile Manager window. 5 (found in Edit menu)

Project Logical Editor… This command launches the Project Logical Editor. 7 depending (found in Project menu)



Range to Next Event This command sends your range to the next event and makes it a zero selection. 7
If you select some dispersed tracks (use 
ctrl), and then create a range in another 
track (not those you selected), giving the 

Range to Previous Event This command sends your range to the previous event and makes it a zero selection 7 See above.

Read ? ?
Although it seems like this would press 

the automation read button, this 
Record Enable R Record enables the selected track(s) 10

Redo Ctrl Shift Z Redoes what you have undone. 10
Rename First Selected Track As it says. 8
Render Audio Click between 

Locators
Bakes your metronome click into an audio track between the locators. 6 (easily accomplished from Signature Track)

Render MIDI Click between 
Locators

Bakes your metronome click into a MIDI track between the locators. 6 (easily accomplished from Signature Track)

Repeat Ctrl K
Brings up the Repeat Events window, from where you can choose how many times the selected 
event/part will be repeated, and whether the repeats will be shared copies of the original. (for 
midi)

10

Reset to Default ? ? ?

Right Selection Side to Cursor D As it says. Makes the right side of the range go to where the cursor currently is. 10

Ruler Display Format Cycles between the available time formats for the ruler in the window with focus. 5 depending

Ruler Mode: Bars+Beats Linear Switches the ruler to Bars+Beats Linear mode. 5

Ruler Mode: Time Linear Switches the ruler to Time Linear mode. 5
Save as Default ? ? ?

Secondary Parameter: Decrease Ctrl Shift Left Pans the focused track to the left, in steps of 10. Works in MixConsole only. 5

If you want to change the pan of many 
adjacent channels:

First get focus on the first channel. Then 
expand the selection using  the key 

command "Project>Select Track:Add 
Next/Prev". Then Q-link the channels and 

give the command. That should do it.
Secondary Parameter: Fine 

Decrease
Pans the focused track to the left, in steps of 1. Works in MixConsole only. 5 See above.

Secondary Parameter : Fine 
Increase

Pans the focused track to the right, in steps of 1. Works in MixConsole only. 5 See above.

Secondary Parameter: Increase Ctrl Shift Right Pans the focused track to the right, in steps of 10. Works in MixConsole only. 5 See above.

Select All Ctrl A As it says. 10

Select All on Tracks
As it says. It will select all events and parts on multiple selected tracks. If there is a range 
defined somewhere, it will use the range to select all.

7



Select Controllers in Note Range As it says. For the duration of the Note, all controllers used will be selected. 7

Select Event ? ? ?
Select Events under Cursor Selects all events intersecting with the cursor. (midi only) 7

Select from Cursor to End Selects everything on the selected track, starting from the cursor until the end of the project. 7

Select from Start to Cursor Selects everything, from the start of the project up to the cursor's position. 7

Select in Loop
Selects everything contained between the locators. If a part/event begins before / ends after 
the locators but crosses their boundaries, they will be selected.

7

Select Next Grid Type
Selects the next grid type. Works with the project window, and the editors. The window that 
has focus gets the command.

8

Select Next Snap Type
Selects the next snap type. Works with the project window, and the editors. The window that 
has focus gets the command.

8

Select None Ctrl Shift A Selects nothing. Or deselects everything. Up to you. 10

Select Prev Grid Type
Selects the previous grid type. Works with the project window, and the editors. The window 
that has focus gets the command.

8

Select Prev Snap Type
Selects the previous snap type. Works with the project window, and the editors. The window 
that has focus gets the command.

8

Set Spacer between Selected 
Events

Brings up a window where you can select the time in seconds that will pass between two 
consecutive events.

5 depending

Show Click Patterns
You need a Signature Track for this command to work. What it does is hide/show the click 
patterns on each signature's flag. (on the Signature Track)

5 (easily done from the Signature Track's arrow 
menu)

Show Lanes
Actually, it's show/hide lanes. You give the command, and the selected track(s) will expand to 
reveal their lanes / contract and obscure their lanes.

Infinite (Can't seem to find it anywhere else)

Snap Off Deactivates snap. 8
Snap On Activates snap. 8

Snap On/Off J Activates/Deactivates snap. 10
Snap Type: Events Sets snap type to events directly. 5

Snap Type: Events + Cursor Sets snap type to events + cursor directly. 5
Snap Type: Events + Grid + 

Cursor
Sets snap type to events + grid + cursor directly. 5

Snap Type: Grid Sets snap type to grid directly. 5
Snap Type: Grid + Cursor Sets snap type to grid + cursor directly. 5
Snap Type: Grid Relative Sets snap type to grid relative directly. 5

Snap Type: Magnetic Cursor Sets snap type to magnetic cursor directly. 5
Snap Type: Shuffle Sets snap type to shuffle directly. 5

Solo S Pushes Solo on the selected track(s). 10
Solo Defeat Pushes Solo Defeat on the selected track(s). 8
Solo Lane Pushes Solo on the selected lane(s). (Only possible if lanes are on different tracks) 7

Split at Cursor Alt X Splits selection at Cursor. Works with normal selections and ranges. 10
Split Loop Splits at the Left and Right Locators. 10

Split Range Shift X Splits at the boundaries of the defined range. 10



Stationary Cursor Alt C
Activates/Deactivates Stationary Cursor. In this mode, the cursor stays in one place and the 
project scrolls continuously, instead of changing pages.

10

Switch MIDI Editor Grid Type
It DOES switch the Key editor's gride type, but so does "Select Next/Prev Grid Type". The only 
reason that this command would have to exist, is if it could change the MIDI editor's grid while 
not in focus. But it does not. So…

0
Probably left over from previous versions, 

or there to ensure that you don't 
accidentally change the project's Grid 

Toggle A/B Setting Toggles A/B settings. 3 Only works for Channel Settings > 
Toggle Link Project and Lower 

Zone Editor Cursors
As it says. Links or unlinks the project's and the lower zone editor's cursors. 5 depending

Undo Ctrl Z Oops! 10

Ungroup Ctrl U
If you used Ctrl G to group some events together for quick editing, this command will allow you 
to disband the group and have the events available as separate entities again.

10

Unlock Ctrl Shift U If you used Ctrl Shift L to Lock an event, you can use this command to unlock it again. 10

Unmute Events Shift U If you used Shift M to mute an event, you can use this command to unmute it again.

Write W ? ?
Although it seems like this would press 

the automation write button, this 
Editors

Edit In-Place Ctrl Shift I Opens In-Place editor for the selected track. (Not audio) 10
Open Audio Part Editor Opens the Audio part editor in a window. 3

Open Audio Part Editor in Lower 
Zone

Opens the Audio part editor in the Lower Zone 3

Open Audio Part Editor in 
Window

Opens the Audio part editor in a window. 3

Open Drum Editor Opens the drum editor in a window. 3

Open Drum Editor in Lower Zone Opens the drum editor in the lower zone. 3

Open Drum Editor in Window Opens the drum editor in a window. 3

Open in separate Window/Lower 
Zone

This command will take the editor in focus from the lower zone to a separate window, and vice 
versa.

8
This is a quick way to hop in and out of 

(quasi)fullscreen editors, without 
Open In-Place Editor Opens In-Place editor for the selected track. (Not audio) 5 Does not toggle. Only opens.

Open Key Editor Opens Key Editor in a window. 3

Open Key Editor in Lower Zone Opens Key Editor in Lower Zone. 3

Open Key Editor in Window Opens Key Editor in a window. 3
Open List Editor Opens the List Editor in a window. 5

Open Sample Editor Opens the Sample Editor in a window. 3
Open Sample Editor in Lower 

Zone
Opens the Sample Editor in the Lower Zone. 3



Open Sample Editor in Window Opens the Sample Editor in a window. 3

Open Score Editor Ctrl R Opens the Score Editor in a window. 10

Open Score Editor in Lower Zone Opens the Score Editor in the Lower Zone. 3

Open Score Editor in Window Opens the Score Editor in a window. 3

Open/Close Editor Return Opens/Closes the current editor. 10
This command will close any editor. When 
a lower zone editor is sent this command, 

Set up Editor Preferences Takes you straight to Preferences > Editors. 5
Export
AAF… Brings up the relevant Export Options window. 3 (easy File>Export)
OMF… Brings up the relevant Export Options window. 3 (easy File>Export)

File

Back up Project
Opens the Set Project Folder window, in order to choose the location where the backup will be 
kept.

5

Close Ctrl W Closes the focused window. 10
Export Audio Mixdown Brings up the Export Audio Mixdown window. 5 Best used in synergy with the Commands 

Export Master Track
Brings up the Export Master Track window, in order to choose the location where the Xml file 
will be kept.

3
File>Export>Tempo Track… is what this 

key command is connected to.

Export MIDI File
Brings up the Export MIDI File window, in order to choose the location where the MIDI file will 
be kept.

3

Export MIDI Loop Brings up the Save MIDI Loop window, in which we can manage saved MIDI Loops. 4

Export MusicXML
Brings up the MusicXML window, in order to choose the location where the MusicXML file will 
be kept. This command will work if you have entered the page mode for the score at least 
once.

4

Export Notepad Data
Brings up the Export Notepad Data, in order to choose the location where the text file will be 
kept.

5

Export Pool
Brings up the Export Pool window, in order to choose the location where the pool file will be 
kept. Must be launched from within the Pool.

3

Export Selected Tracks
Brings up the Export Selected Tracks window. This is not an Audio Mixdown. It is an export of 
the tracks.

4

Export Video Brings up the Export Video window. 4
Import Audio File Brings up the Import Audio window, in order to choose the audio file for import. 4

Import Audio from Video
Brings up the Import Audio from Video window, in order to choose the video from which the 
audio will be taken.

4

Import from Audio CD
Brings up the Import from Audio CD window, in which the CD drive is selected, along with the 
tracks to be imported.

4

Import Master Track Brings up the Import Master Track window, in order to choose the Xml file for import 4
File>Import>Tempo Track… is what this 

key command is connected to.

Import MIDI File
First asks if we want to create a new project. Regardless of choice, it then brings up the Import 
MIDI File window, in order to choose the MIDI file for import.

4



Import MusicXML Brings up the Import MusicXML window, in order to choose the MusicXML file for import. 4

Import Pool
Brings up the Import into Pool window, in order to choose the pool file for import. Must be 
launched from within the Pool.

4

Import Track Archive
Brings up the Locate Track File window, in order to choose the xml file of the desired track for 
import.

4

Import Tracks from Project
Brings up the "Select a project to merge with the active one" (!) window, in order to choose a 
project as a source for import.

4

Import Video File Brings up the Import Video window, in order to choose the video for import. 4
New Ctrl N Creates a new project. Depending on preferences, the Hub may pop up. 10

New Library Brings up the Set Project Folder location. 4
Open Ctrl O Brings up the Open Project window, in order to choose the project to open. 10

Open Library Brings up the Open Library window, in order to choose the pool file. 4
Page Setup… Brings up the Page Setup window. Must be launched from the Score Editor. 4

Print Brings up the Print window. Must be launched from the Score Editor. 4
Quit Ctrl Q Quits Cubase. If you have unsaved changes, you are prompted to save first. 10

Revert Reverts to the previously saved version. 4
Save Ctrl S Saves! 10

Save As Ctrl Shift S Saves under a different file name. 10
Save as Template Saves as a template. 4

Save Library… Saves the library. 4
Save New Version Ctrl Alt S Saves a new version of the project. 10

Scores…
Brings up the Export Scores window, in order to choose the path, name and file type the scores 
will be exported as.

4

Write MIDI File to Project Folder Automatically exports a MIDI file to the project's folder. 6

Focus
Through trial and error, aid from assigned 
navigation keys, and sheer luck, you can 

Back Moves focus to the previous focus point?

Confirm Alt Return
Multifunctional key. At times loads plug-ins, other times expands tabs, other times activates 
sends. It's a key of action! Do I know what it does exactly? No.

10

Escape Lose focus?
Forward Moves focus to the next focus point?

HeadTracking
Head Tracking Brings up the Head Tracking panel. 3 (Easily accessible in Project menu)

Hitpoints
All the commands work with multiple 

selections (1 tool). If a range is selected (2 
tool), hitpoint processing will apply to the 

Calculate
Allows you to manually create Hitpoints for the selected event(s). (If 
Preferences>Editing>Audio>Enable Automatic Hitpoint Detection is unticked)

7

Create Audio Slices from 
Hitpoints

Slices up the selected event(s) at their hitpoints, and bundles all those new events (slices) into a 
part.

7



Create Markers from Hitpoints As it says. This command will create a marker for each hitpoint encountered. 7

When we use this command on multiple 
tracks and events, the numbering of the 
markers goes like this: Marker 1 will be 

the first hitpoint of the first event 
selected. Marker x will be the last hitpoint 

of the last event selected on the same 
track. Marker x+1 will be the first hitpoint 
of the first event selected on the second 

Divide Audio Events at Hitpoints This will take the scissors to the events, and split them at the hitpoints' positions. 7

Remove Hitpoints
If you are not happy with the detected hitpoints (automatically detected or otherwise) you can 
use this command to remove them all. Will also work with multiple selections.

7

Hub
Hub Brings up the Hub panel. 5

Import
AAF… Brings up the Import AAF window, in order to choose the file. 4
OMF… Brings up the Import OMF window, in order to choose the file. 4

Inspector

Instrument Tracks have problems with a 
few of these commands, probably due to 

the "dual" setup present on their 
inspector. Not all Sections are on the 

Open Next Section Opens the next Inspector Section. You can cycle through all of them with this command. 5

If you have Sections pinned, the 
command will skip to the next unpinned 

section and open that one instead.

When trying to cycle through instrument 
tracks WITH OR WITHOUT PINNED 

SECTIONS though, it seems that this 
command gets stuck when it reaches the 

"Instrument" Section. I guess that's 
because "Instrument" gets its own setup, 

and the entries are nested within, on a 

Open Previous Section Opens the previous Inspector Section. You can cycle through all of them with this command. 5
See above. BUT, when you have NO 

Sections pinned, this command will allow 

Toggle Channel Section Opens/Closes the Fader. 5
Should be renamed to Fader Section

Does not work for Instrument Tracks' 
Toggle Cue Sends Section Opens/Closes Cue Sends Section. 5 Instrument Tracks don't have a Cue Sends 

Toggle Device Panel Section Opens/Closes Device Panel Section. 5

Toggle Direct Routing Section Opens/Closes Direct Routing Section. 5



Toggle Equalizers Section Opens/Closes Equalizers Section. 5

Toggle Expression Map Section Opens/Closes Expression Map Section. 5

Toggle Inserts Section Opens/Closes Inserts Section 5 When used on an Instrument Track, it will 

Toggle MIDI Modifiers Section Opens/Closes MIDI Modifiers Section 5

Toggle Note Expression Section Opens/Closes Note Expression Section 5

Toggle Notepad Section Opens/Closes Notepad 5

Toggle Quick Controls Section Opens/Closes Quick Controls Section 5

Toggle Sends Section Opens/Closes Sends Section 5 Does not work with Instrument Tracks.

Toggle Standard Section Opens/Closes Standard Section. This is the very first section, with the track's name in color. 5

Macro - Not Covered
Marker

Activate Marker Track Activates the currently selected marker track. (if we are using more than one) 3 (easily found on the marker track itself)

Insert and name Cycle Marker
Inserts a cycle marker between the left and right locators, and opens the Markers window with 
the description field ready for input.

7
Doesn't work with ranges or selections. A 

pity.

Insert and name Marker
Inserts a marker at the cursor's position, and opens the Markers window with the description 
field ready for input.

7

Media

Add Favorite With MediaBay open and a folder selected, give this command to save the folder to Favorites. 6

Browse: Back The Back button of the MediaBay browser 6
Browse: Forward The Forward button of the MediaBay browser 6

Browse: Up The Up button of the MediaBay browser 6

Convert Files
When a file is selected in the Pool, you can use this command to convert the files to a new 
sample rate.

3 (Media menu)

Create Folder In Pool, creates a new folder. 3 (easily found on right click menu)

You can only add a folder beneath Audio, 
or Video. You cannot add a root folder on 

the same level with those two.

Create New Folder In MediaBay, creates a new folder under the selected path.
inf. (Can't seem to find a button to create folders in 

MediaBay browser)
The name of the command should be 

"MediaBay: Create New Folder" for more 

Create Sampler Track Creates a Sampler Track from the selected file. Works in Pool and MediaBay browser. 3 (easily found on right click menu)
Not to be confused with 

Commands>Audio>Create Sample Track
Empty Trash Empties the trash folder in Pool. Works from the Project window too. 3 (easily found on right click menu in Pool)

Find Missing Files
Brings up the Resolve Missing Files window, in order to choose the path where the missing files 
are located.

0 (easily found on right click menu in Pool, pops up 
first when loading a project with files missing)



Generate Thumbnail Cache
From the manual: "You can manually generate thumbnail cache files. This is necessary if a 
thumbnail cache file could not be generated during import because the folder is write-
protected, or because you have edited the file with an external video editing application."

3 (easily found in Media menu)

Personally, when I hear "Thumbnail", my 
mind goes to Videos and Photos. This 

command remains available always, so 
I'm guessing it's a global command 

Hide Folders That Are Not 
Scanned

In MediaBay, hides all the folders that have not been scanned. 3 (found in MediaBay Settings cog)

Import Audio from Video Crashes my Cubase, so I don't know what it does. ? Not to be confused with File>Import 

Import from Audio CD Opens Pool window in the background, and the Import Audio CD window in the foreground.

Import Medium
Opens Pool window in the background, and the Import Medium window in the foreground, in 
order to choose a file for import (audio or video). (Presses the Import button in the Pool)

3 (button in Pool)

Insert into Project at Cursor
Inserts the file selected in the Pool at the Cursor's position. Creates a new track if no track is 
selected.

5 (Media menu)
While the key for the key command is 

shown next to the command in 
Media>Insert into Project, if you go to 

Insert into Project at Left Locator
Inserts the file selected in the Pool at the Left Locator. Creates a new track if no track is 
selected.

5 (Media menu)
While the key for the key command is 

shown next to the command in 
Media>Insert into Project, if you go to 

Insert into Project at Origin Inserts the file selected in the Pool at its Origin. Creates a new track if no track is selected. 5 (Media menu)
While the key for the key command is 

shown next to the command in 
Media>Insert into Project, if you go to 

Loop Browser Launches the Loop Browser 5 (Media menu)

New Version Creates a new version of the file selected in the Pool just underneath. 5 (Media menu)
While the key for the key command is 

shown next to the command in Media, if 
you go to Pool>Right click on file, the 

Open MediaBay F5 Opens MediaBay 10

Open/Close Attribute Inspector Ctrl Alt Num 6 Opens/Closes the Attribute Inspector in the MediaBay 10?

This command is a show/hide right zone 
for the MediaBay, Loop Browser, and 

Sound Browser windows. Why have an 
extra command then? Because, if you 

activate Always on Top, this keycommand 
will work regardless of which window has 
focus (Project, Mixconsole). However, if 

we have all three windows open and 
always on top (MediaBay, Loop Browser, 

Sound Browser), the window that gets the 
command is MediaBay. If we close 

Open/Close Favorites Ctrl Alt Num 8 Opens/Closes Favorites in the MediaBay (Doesn't work for me. Not ready yet?) 10? See above.
Open/Close File Browser Ctrl Alt Num 4 Opens/Closes File Browser in the MediaBay 10? See above.

Open/Close Filters Ctrl Alt Num 5 Opens/Closes Filters in the MediaBay 10? See above.
Open/Close Previewer Ctrl Alt Num 2 Opens/Closes the Previewer in the MediaBay 10? See above.



Prepare Archive
Gathers all referenced files to the project's directory, with an option to flatten edits. Video files 
(if any) must be copied manually. Files in the project's directory must then be moved inside the 
Audio folder.

3-8 depending

Preview Active On/Off ? ?
I don't know what this does. Maybe it was 

there as an option before "Open/Close 

Preview AutoPlay On/Off Toggles AutoPlay mode of the Previewer On and Off. Good for a quick listen. 6

If the Right Zone of the project window 
has focus, and only then, the command 

will go there, no matter if you have A 
MediaBay window open and always on 

Preview Cycle On/Off Shift Num / Toggles the Preview Cycle On and Off. 6 See above.

Preview in Context On/Off
The Preview is played at the Tempo of the Project. The button tooltip says "Align Beats to 
Project"

6 See above.

Preview Pause On/Off Pauses and resumes the preview playback. 6 See above.
Preview Start Shift Enter [Numpad] Starts the preview if AutoPlay is not enabled. 6 See above.
Preview Stop Shift Num 0 Stops the preview 6 See above.

Preview Sync On/Off
Allow you to use the regular transport button for the preview, perhaps to evaluate it in the 
project's context. The button tooltip says "Wait for Project Play".

6 See above.

Reconstruct
In Pool, if an audio file is missing its edit file, it may be possible to reconstruct the edit file using 
this command.

3 (Media menu)

Refresh Views
A refresh command for the MediaBay, Loop Browser, and Sound Browser, in case you change 
something from outside Cubase.

6

Remove Favorite Removes the selected Favorite in MediaBay. 6

Remove Missing Files
In Pool, if the project complains about missing files, you can choose to remove them outright, 
so that events in the project window that point to those missing files are also removed.

3 (Media menu)

Remove Unused Media
In Pool, if there exist files that are not used in the project, this command will remove them. You 
can see which files are unused in the Pool with the help of the "Used" column. If no number 
exists in this column, the file is unused.

3 (Media menu)

Rescan Disk Use this command to rescan the disk or folders for (new?) files. 6
I'm not very confident that I really 

understand the differences between this 

Reset All Filters
In Mediabay, Loop Browser, and Sound Browser, resets all filters. (Those in the Top "Filter" 
Zone, and the Results Filter in the toolbar.)

6

Reset Result Filters
In MediaBay, Loop Browser, and Sound Browser, resets only the Result Filters (those in the 
toolbar)

6

Reset Search In MediaBay, Loop Browser, and Sound Browser, resets the whole search. 6
Results: Include Folders and 

Subfolders
Toggles the "Include Folders and Subfolders" button, which allows the search to look just in the 
selected folder, or in all subfolders included down the path.

6

Revert Not sure. Takes you back to the previous successful search? The function is not clear to me. 6

Search MediaBay Shift F5 Opens MediaBay and readies the search field for keyboard input. 10

Select in Project
In Pool, select the file you want. Give the command and observe how all events referencing the 
file have been selected.

7



Select Media Types
In MediaBay, Loop Browser, and Soundbrowser, opens the Show Media Types panel. (next to 
the search field)

6
You can navigate up and down with the 
arrow keys, and select/deselect entries 

Set Record Folder
In Pool, if you have created many folders under the "Audio" main folder, you can use this 
command to set the selected folder as the record folder.

3 (available in right click menu)

Show in Explorer
Shows where the selected file is stored on the computer. Works in the Pool, and in MediaBay / 
LoopBrowser / Soundbrowser "Results" Zone.

3 (Media menu, right click menu) Should be one command really.

Show in Explorer
Shows where the selected folder is on the computer. Works for the left Zone of MediaBay / 
LoopBrowser /Soundbrowser.

3 (right click menu) Should be one command really.

Show Only Selected Folder Toggles MediaBay Setting "Show Only Selected Folder". 3 (found in MediaBay Settings cog)

Shuffle Results In MediaBay, Loop Browser, and Soundbrowser, shuffles (randomly reorders) the results. 3 (toolbar button)

Sound Browser Launches the Sound Browser 3 (Media menu)

Stop Updating Results
You can give this command while the MediaBay is populating the list of results to make it 
pause.

3 (toolbar button)

Write Attributes to File
Not sure. This command exists in the Pool's right click menu, but the key command key is not 
shown next to it. On the other hand it shows next to the corresponding entry in the Media 
menu. In MediaBay, changing of attributes is done automatically I believe.

? ?

MediaInspector
This command category does not exist at 

first! Right clicking in the MediaBay 
Attribute Inspector will make it available 

Remove Attribute Removes the selected Attribute in MediaBay's Attribute inspector. 3 (available in right click menu)
Search for [] Searches for the selected attribute. 3 (available in right click menu)

MIDI

Auto Select Controllers
Activates/Deactivates Auto Select Controllers. When active, selecting a MIDI event (note), will 
select all Controllers under it.

5 (available in toolbar)

Bounce MIDI This command will bounce the selected midi events into one. 8 (MIDI menu)
Controller Lane Setup 1 None? ? Alas, does nothing for me here.
Controller Lane Setup 2 None? ? Alas, does nothing for me here.
Controller Lane Setup 3 None? ? Alas, does nothing for me here.
Controller Lane Setup 4 None? ? Alas, does nothing for me here.
Controller Lane Setup 5 None? ? Alas, does nothing for me here.
Controller Lane Setup 6 None? ? Alas, does nothing for me here.
Controller Lane Setup 7 None? ? Alas, does nothing for me here.
Controller Lane Setup 8 None? ? Alas, does nothing for me here.
Controller Lane Setup 9 None? ? Alas, does nothing for me here.

Controller Lane Setup 10 None? ? Alas, does nothing for me here.
Controller Lane Setup 11 None? ? Alas, does nothing for me here.
Controller Lane Setup 12 None? ? Alas, does nothing for me here.
Controller Lane Setup 13 None? ? Alas, does nothing for me here.
Controller Lane Setup 14 None? ? Alas, does nothing for me here.
Controller Lane Setup 15 None? ? Alas, does nothing for me here.



Controller Lane Setup 16 None? ? Alas, does nothing for me here.

Delete Continuous Controllers
Make a selection of parts. Give the command. Observe how all CCs have been deleted. Also 
works with range selections. Any part caught in the range will have ALL CCs deleted.

6 (MIDI>Functions)

Delete Controllers Not sure. The same as "Delete Continuous Controllers"? ? ?

Delete Doubles
This command will delete notes that occupy the same pitch at the same time. It also works for 
CCs, removing consecutive extra entries with the same value.

6 (MIDI>Functions)

Delete Notes
Brings up the Delete Notes window, where we can select the minimum length of the notes to 
be deleted, the minimum velocity, and whether one or both condition should apply.

6 (MIDI>Functions)

Delete Overlaps (mono) This command will delete overlaps of events of the same pitch (overlapping unisons) 6 (MIDI>Functions)
I don't know if "mono" is a good 

description.

Delete Overlaps (poly) This command will delete any overlaps of events of any pitch. (including unisons) 6 (MIDI>Functions)
Unless I'm missing something, this 
command does exactly as "Delete 

Dissolve Part
Brings up the Dissolve Part window, in which we can choose to Dissolve in separate channels, 
or separate pitches, the option to optimize display and the option to dissolve to lanes.

6 (MIDI>Functions)
Optimize display will remove silent areas 
of the resulting parts, but not when CCs 

are there.
Drum Editor: Show Note Length 

On/Off
Toggles Show Note Length for the Drum Editor 3 (available on Toolbar)

Drum Map Setup… Opens the Drum Map Setup window. 3 (available in both Inspector and Drum Editor)

Expression Map Setup… Opens the Expression Map Setup window. 3 (available in Left Zone's Inspector>Editor)
Extract MIDI Automation Deletes all CCs of the selected part, and makes them automation lanes instead. 6 (MIDI>Functions)

Fixed Lengths Fixes length of the events in the selection to the selected quantize value. 6 (MIDI>Functions)
Fixed Velocity Fixes velocity of the events in the selection to the selected Insert Velocity value. 6 (MIDI>Functions)

Freeze Length
Not sure. I think it should control the button "Freeze MIDI Lengths" in the Length Section of the 
Inspector>Editor. 

? ?

Freeze MIDI Modifiers
Freezes any MIDI modifiers currently applied from the MIDI Modifiers Section of the Inspector. 
This means that the Modifiers will be applied to the MIDI track (observe how the events 
change), and their values reset to zero.

3 (available in Left Zone's Inspector>Track)

Insert Velocity 1 Directly selects Insert Velocity 1 8 (available on toolbar) You can modify the presets from the 
Insert Velocity 2 Directly selects Insert Velocity 2 8 (available on toolbar) See above.
Insert Velocity 3 Directly selects Insert Velocity 3 8 (available on toolbar) See above.
Insert Velocity 4 Directly selects Insert Velocity 4 8 (available on toolbar) See above.
Insert Velocity 5 Directly selects Insert Velocity 5 8 (available on toolbar) See above.

Legato Applies Legato to the selection. (Apply Legato button of Length Section in Inspector>Editor) 8 (available in Length Section in Inspector>Editor)

Logical Editor… Launches the Logical Editor 6 depending

Merge MIDI in Loop
Merges all MIDI caught between the Left and Right Locators to the selected tracks. First brings 
up the MIDI Merge Options window.

6 depending



Merge Tempo from Tapping
Allows you to have the Tempo track follow your tapping. To do this, you need the MIDI track in 
Linear Time Base. Record your tapping along to the music. Then give the command. In the 
"Tempo from Tapping" window, select the value which you were tapping at. Done.

4 depending

Mirror This will mirror the selection. Works on multiple parts, works with ranges. 7 depending
O-Note Conversion Performs O-Note Conversion. Pitches are set according to their O-Notes. 4 (MIDI menu)

Open CC Automation Setup 
Dialog

Brings up the MIDI Controller Automation Setup window, in which we configure how CC to 
automation transformations will be handled.

4 (MIDI menu)

Open Insert Velocities Dialog
Brings up the "MIDI Insert Velocities" Dialog, where we can set up the velocity values of the 5 
Levels.

8 (MIDI menu)
It's called "Insert Velocities…" in the MIDI 

menu.

Pedals to Note Length
Not sure. Per manual, this command is supposed to elongate the note up to the point where 
the recorded sustain pedal is released, and then deletes the sustain controller. In practice, it 
doesn't always work as expected, or it's me that doesn't understand all parameters.

0 (MIDI>functions) Not quite working

Record in Editor Activates Record in Editor. 3 depending (on toolbar)

Repeat Loop
This command is about the "Independent Track Loop". It will fill the whole part with what's 
caught in the independent loop.

1 (needs preparatory actions)
Should be "Repeat Independent Track 

Loop" for clarity.
Reset Performs a "Reset MIDI Devices" 3 (Last in MIDI) Should be "Reset MIDI Devices" for 

Restrict Polyphony
Brings up an Allow window where we set the number of Allowed voices. If we select 1, event 
lengths will be changed so that notes do not overlap.

5 (MIDI>Functions)

Reverse This is like mirror, except it doesn't function as I would expect. 3 (MIDI>Functions) Not what I expected.
Send All Notes Off Message Not sure if this works. Using MIDI Monitor, I don't see any Notes Off Messages. ? Does it work?

Show Used Controllers
As it says. Shows all the controllers used in a selection. If multiple parts are selected, the 
command will only show the controllers used by ALL parts.

7 (In Editor's "Controller Lane Setup" pop-up.

Show/Hide Controller Lanes Alt L As it says. 10 (In Editor's "Controller Lane Setup" pop-up.
The key for the Key Command does not 

show up next to the command in the 

Thin Out
Thins out MIDI data. (For example, if a CC contains a lot of redundant points, those will be 
removed upon using this command.)

7 (MIDI>Functions)

Toggle Computer Keyboard Input
Toggles Computer Keyboard Input On/Off in the Score Editor, allowing input of notes by 
pressing the respective key. (C for C, D for D, e.t.c.)

8 (In Score Editor's Toolbar) Score Editor only.

Toggle MIDI Input Toggles MIDI input in Editors. (Record in Editor is activated automatically) 5 (In Editors' Toolbars)
Toggle Step Input Toggles Step Input in Editors. (Record in Editor is activated automatically) 5 (In Editors' Toolbars)

Transpose Brings up the "Transpose Setup" window, with options for the planned transposition. 5 (In MIDI menu)

Transpose Notes
This command is the "Apply Transpose" Button, in Inspector>Editor Transpose Section. Once 
you select the number of semitones in the field, you give this command, and the transposition 
is applied.

3

Velocity
Brings up the "Velocity" window, with options to select the type of velocity change, and the 
wanted values.

3

MixConsole History
Undo MixConsole Step Oops! 10 It's worth it to assign this key command.
Redo MixConsole Step Alt Shift Z Redoes what you have undone. 10



MixConsole Snapshots
Save MixConsole Snapshot Saves a snapshot of the MixConsole's status. 5 depending

Mixer
Activate Record Enable for All 

Audio Tracks
As it says. Record enables all audio tracks. 8 depending

Add Track To Selected: FX 
Channel

Brings up the Add Track dialog, ready to create an FX track. The selected tracks upon which the 
command was given will use their next available send to connect to this FX track.

10 (I use Ctrl Alt F)

Add Track To Selected: Group 
Channel

Brings up the Add Track dialog, ready to create a Group track. The selected tracks upon which 
the command was given will have their outputs routed to this Group track.

10 (I use Ctrl Alt G)

Add Track To Selected: VCA 
Fader

Brings up the Add Track dialog, ready to create a VCA Fader track. The selected tracks upon 
which the command was given will have their faders connected to this VCA Fader.

10 (I use Ctrl Alt V)

Bypass: Channel Strip Bypasses the Channel Strip (except EQ) everywhere in the MixConsole. 7 depending
Bypass: Channel Strip on Main 

Mix
Bypasses the Channel Strip (except EQ) just on the Main Mix. 8 depending

Bypass: EQs Bypasses the EQ section everywhere in the MixConsole. 7 depending
Bypass: EQs on Main Mix Bypasses the EQ section just on the Main Mix. 8 depending

Bypass: Inserts Bypasses the Insert section everywhere in the MixConsole. 7 depending
Bypass: Inserts on Main Mix Bypasses the Insert section just on the Main Mix. 8 depending

Deactivate Record Enable for All 
Audio Tracks

As it says. Record disables all audio tracks. 8 depending

Direct Routing: Summing Mode 
On/Off

Toggles Summing Mode On/Off 6 depending (Functions Menu in MixConsole)

Edit Channel Settings for selected Brings up the Channel Settings window. 10
Between this command, and Edit>Edit 

Channel Settings, IF there are any 
EQ/Filter Transition: Quick Changes EQ/Filter behavior to quick. 6 depending (Functions Menu in MixConsole)
EQ/Filter Transition: Soft Changes EQ/Filter behavior to soft. 6 depending (Functions Menu in MixConsole)

Expand: Channel Strip Expands/Reduces the Channel Strip section. 5 depending
Expand: Cue Sends Expands/Reduces the Cue Sends section. 5 depending

Expand: Device Panels Expands/Reduces the Device Panels section. 5 depending
Expand: Direct Routing Expands/Reduces the Direct Routing section. 5 depending

Expand: EQs Expands/Reduces the EQ section. 5 depending
Expand: Filters/Gain Expands/Reduces the PRE section. 5 depending

Expand: Inserts Expands/Reduces the Inserts section. 5 depending
Expand: Quick Controls Expands/Reduces the Quick Controls section. 5 depending

Expand: Routing Expands/Reduces the Routing section. 5 depending
Expand: Sends Expands/Reduces the Sends section. 5 depending
Expand: VCA ? ? Expand VCA?

File: Load Selected Channels Loads the selected channels' mixer state from a file. 5 depending
File: Save Selected Channels Saves the selected channels' mixer state to a file. 5 depending



Hide: Audio Shows/Hides Audio channels. 5 depending
Hide: Groups Shows/Hides Group channels. 5 depending
Hide: Inputs Shows/Hides Input channels. 5 depending

Hide: Instruments Shows/Hides Instrument channels. 5 depending
Hide: MIDI Shows/Hides MIDI channels. 5 depending

Hide: Outputs Shows/Hides Output channels. 5 depending
Hide: Returns Shows/Hides FX channels. 5 depending
Hide: ReWire Shows/Hides ReWire channels. 5 depending

Hide: VCAs Shows/Hides VCA channels. 5 depending

Link Channels
Brings up the Link Group Settings window, in order to choose what will be linked among all the 
selected channels.

5 depending

Link Group: Edit Link Group 
Settings

Brings up the Link Group Settings window, in order to edit the settings of the link group that 
the selected channel belongs to.

5 depending

Link Group: Next Link Group Selects the next Link Group. 7 depending

Link Group: Previous Link Group Selects the previous Link Group. 7 depending

Listen for All Visible Channels 
On/Off

Pushes Listen for All Visible Channels. 6 depending

Loudness: Enable Toggle Measure Loudness (Right Zone>Meter>Loudness) 6 depending
Loudness: Reset Resets Loudness Measurement (Right Zone>Meter>Loudness) 6 depending

Loudness: Switch between +9dB 
and +18dB Scale

Perfectly explained. 6 depending

Loudness: Switch between LU 
and LUFS

Perfectly explained. 6 depending

Master Meter: AES17 (+3dB) Perfectly explained. (Right Zone>Meter>Master, in settings cog)
Meters: Hold Forever Activates/Deactivates "Hold Forever" for the meters. 7 depending
Meters: Hold Peaks Activates/Deactivates "Hold Peaks" for the meters. 7 depending

Meters: Input Moves the meters' position to the input. 5 depending
Meters: Post Fader Moves the meters' position to post fader. 5 depending

Meters: Post Panner Moves the meters' position to post panner. 5 depending

Pre/Post
Switches the focused Send Slot between Pre/Post. Works in MixConsole, Channel Settings, not 
in the Inspector Section though.

1

Q Link Activates/Deactivates Quick Link (Acts as Toggle, no need to keep pressed like Alt) 10

Show All ? Not sure. I can't find out what this does. (I have an idea but I don't want to jinx it!) ? ?

Show/Hide Channel Overview Shows/Hides the Channel Overview in the MixConsole. 7 depending

Show/Hide Channel Racks Shows/Hides the Channel Racks in the MixConsole, leaving you with just the fader section. 8 depending

Show/Hide Channel Selector ? Not sure. I can't find out what this does. (I have an idea but I don't want to jinx it!) ? ?



Show/Hide Control Room/Meter
? Not sure. I am guessing this should be a separate key command for the MixConsole's Right 
Zone, but it doesn't do anything for me.

? ?

Show/Hide Equalizer Curve Shows/Hides the Equalizer Curve in the Racks section. 7 depending
Show/Hide Meter Bridge Shows/Hides the Meter Bridge in the Racks section. 7 depending

Show/Hide Notepad Shows/Hides the Notepad in the Racks section. 7 depending
Show/Hide Pictures Shows/Hides the Track Pictures in the Racks section. 7 depending

Unlink Channels Unlinks channels previously in a Link Group. 5 depending
Views: Channel Strip Shows/Hides the Channel Strip Rack. 8 depending

Views: Cue Sends Shows/Hides the Cue Sends Rack. 8 depending
Views: Device Panels Shows/Hides the Device Panels Rack. 8 depending
Views: Direct Routing Shows/Hides the Direct Routing Rack. 8 depending

Views: EQs Shows/Hides the EQ Rack. 8 depending
Views: Filters/Gain Shows/Hides the PRE Rack. 8 depending

Views: Inserts Shows/Hides the Inserts Rack. 8 depending
Views: Quick Controls Shows/Hides the Quick Controls Rack. 8 depending

Views: Routing Shows/Hides the Routing Rack. 8 depending
Views: Sends Shows/Hides the Sends Rack. 8 depending
Views: VCA ? ? ?

Windows: Close All Plug-Ins Closes all open plug-in windows. 9

Zoom In Horizontal Zoom In for the MixConsole. 5-10 depending
If you have "Use Standard Zoom 

Commands" enabled in Functions 
Menu>Zoom, both the regular key 

Zoom In Vertically Vertical Zoom In for the MixConsole. 5-10 depending See above.
Zoom Out Horizontal Zoom Out for the MixConsole. 5-10 depending See above.

Zoom Out Vertically Vertical Zoom Out for the MixConsole. 5-10 depending See above.
Navigate

Add Down Shift Down Adds to selection for direction down. Removes from selection for direction up. 10 Transposes 8vb in Key Editor.
Add Left Shift Left Adds to selection for direction left. Removes from selection for direction right. 10

Add Right Shift Right Adds to selection for direction right. Removes from selection for direction left. 10
Add Up Shift Up Adds to selection for direction up. Removes from selection for drection down. 10 Transposes 8va in Key Editor.

Back ? Not sure. I can't find out a place where I can navigate back. ? ?
Bottom End Goes to the the bottom track. 10
Down Down Moves down in the project window. 10 Moves one Semitone down in Key Editor.

Forward ? Not sure. I can't find out a place where I can navigate forward. ? ?
Left Left Selects previous in project window. 10 Selects previous event in Key Editor.
Less ? Not sure. I can't find out a place where I can show less. ?

More ? Not sure. I can't find out a place where I can show more. ?
Right Right Selects next in project window. 10 Selects next event in Key Editor.

Set Remote-Control Focus on 
Next Plug-in

If you have VST Instruments loaded, this command will move the remote control focus to the 
next plug-in.

6?

Set Remote-Control Focus on 
Previous Plug-in

If you have VST Instruments loaded, this command will move the remote control focus to the 
previous plug-in.

6?



Toggle Selection Ctrl Space ? Not sure. I don't know what selection this is supposed to toggle. 10? ?
Top Home Selects the top track in the project window. 10
Up Up Moves up in the project window. 10 Moves one Semitone up in the Key Editor.

Note Expression
Consolidate Note Expression 

Overlaps
When two notes overlap and contain note expressions for the same controller, this command 
will use the second note's data for the overlap.

6 (MIDI>Note Expression)

Convert to Note Expression Converts CCs to Note Expression. 6 (MIDI>Note Expression)
Dissolve Note Expression Converts Note Expression to CCs. 6 (MIDI>Note Expression)

Edit Next Parameter Edits the next parameter with data. 8
Edit Previous Parameter Edits the previous parameter with data. 8

Editor Size: Decrease Cycles between 3 different sizes for the Note Expression editor, from large to small. 8

Editor Size: Increase Cycles between 3 different sizes for the Note Expression editor, from small to large. 8

Note Expression MIDI Setup Brings up the Note Expression MIDI Setup window. 6 (MIDI>Note Expression)
Open/Close Editor Opens/Closes the Note Expression editor. 8

Paste Note Expression ? Not sure. I can't paste note expression with this command. On the other hand Ctrl V works. ? ?

Record MIDI as Note Expression ? Not sure. I can't Enable/Disable "Record MIDI as Note Expression" with this command. ? ?

Remove Note Expression Removes Note Expression. 8

Resolve Note Expression Distributes Notes to MIDI Channels. 8
Either MIDI>Note Expression>Distribute 

Notes to MIDI Channels should be 
renamed to "Resolve Note Expression", or 

Show/Hide Note Expression Data Shows/Hides Note Expression Data on the notes themselves in the Key Editor. 9

Trim Note Expression to Note 
Length

As it says. Shortens Note Expression to match the length of the note. 9

Nudge

Down Nudges down. Down key accomplishes the same in the Key Editor for selected events. 10 (I have it assigned to Alt Down)

Down (Larger Step)
Nudges down by a larger amount. Shift Down accomplishes the same in the Key Editor for 
selected events, transposing them down by an octave.

7

End Left Alt Shift Left
Nudges the end of the event/part to the left by the amount dictated by the grid type setting, 
and the quantize setting.

10

End Right Alt Shift Right
Nudges the end of the event/part to the right by the amount dictated by the grid type setting, 
and the quantize setting.

10

Graphical Bottom ? Not sure. This command doesn't seem to do anything for me. ? ?
Graphical Left ? Not sure. This command doesn't seem to do anything for me. ? ?

Graphical Right ? Not sure. This command doesn't seem to do anything for me. ? ?
Graphical Top ? Not sure. This command doesn't seem to do anything for me. ? ?



Left Ctrl Left
Nudges the whole selection left by the amount dictated by the grid type setting, and the 
quantize setting.

10

Loop Range Left
Nudges the loop (space in between left and right locators) to the left by the amount dictated by 
the grid type setting, and the quantize setting.

9

Loop Range Right
Nudges the loop (space in between left and right locators) to the right by the amount dictated 
by the grid type setting, and the quantize setting.

9

Right Ctrl Right
Nudges the whole selection right by the amount dictated by the grid type setting, and the 
quantize setting.

10

Start Left Alt Left
Nudges the start of the event/part to the left by the amount dictated by the grid type setting, 
and the quantize setting.

10

Start Right Alt Right
Nudges the start of the event/part to the right by the amount dictated by the grid type setting, 
and the quantize setting.

10

Up Nudges up. Up key accomplishes the same thing in the Key Editor for selected events. 10 (I have it assigned to Alt Up)

Up (Larger Step)
Nudges up by a larger amount. Shift Up accomplishes the same in the Key Editor for the 
selected events, transposing them up by an octave.

7

Preferences
Audio - Background Color 

Modulation
Activates/Deactivates background color modulation. 3

It seems that background color 
modulation doesn't work with 

Audio - Create Audio Images 
during Record

Activates/Deactivates. When active, the audio images (waveforms in the events) are created as 
record runs. When inactive, during record the event remains blank, and when recording stops, 
it's then that the images are constructed.

3

Audio - Default Warping 
Algorithm

Chooses the next available warping algorithm as the default. 0
This key command is a one way street. 

Once I reach the end, i.e. Standard - Solo, 

Audio - Enable Automatic 
Hitpoint Detection

Activates/Deactivates automatic Hitpoint detection. 5 depending

This comand does not create Hitpoints 
itself, neither is it retroactive. This means, 
if you have Automatic Detection enabled 

and record an event, you will get 
Hitpoints. Now, if you give the command, 

the hitpoints will not dissapear for this 

Audio - Interpolate Audio 
Waveforms

Activates/Deactivates interpolation of audio waveforms. 5 depending
This command interpolates sample values 
to form curves when you zoom in to one 
sample per pixel or less. Keep this in mind 

Audio - On Processing Shared 
Clips

Cycles through the options for what should be done when applying processing to shared clips. 5 depending

Audio - Remove 
Regions/Hitpoints on all Offline 

Processes
Activates/Deactivates removal of hitpoints and regions when offline processes are applied. 5 depending

Audio - Show Event Volume 
Curves Always

Activates/Deactivates visibility of the volume curve (envelope) for an audio event, even if 
deselected. When activated, the curve will always show.

7 depending

Audio - Show Hitpoints on 
Selected Events

Activates/Deactivates visibility of the hitpoints when the event is selected. When activated, 
once you select an event you will see its hitpoints on it.

7 depending



Audio - Show Waveforms
Activates/Deactivates visibility of waveforms for audio events. When activated, you see 
waveforms in events. When deactivated, events remain blank.

5 depending

Audio - Snap to Zero Crossing Activates/Deactivates Snap to Zero Crossing. 8
This is not a preference. This is a toolbar 
command. I would like it if they had their 

Audio - Time Stretch Tool 
Algorithm

Chooses the next available time stretch algorithm for the time stretch tool. 0
This key command is a one way street. 

Once I reach the end, i.e. Realtime, I don't 

Audio - Treat Muted Audio 
Events like Deleted

Activates/Deactivates. When activated: If you have 2 events overlapping, and the event on top 
is muted, the overlapped section of the event in the back will playback normally. When 
deactivated: If you have 2 events overlapping, and the event on top is muted, the overlapped 
section of the event in the back will not play back. Only the section of the event NOT covered 
by the muted event in the foreground will play.

3 (not something to change frequently I imagine)

Audio - Use Mouse Wheel for 
Event Volume and Fades

Activates/Deactivates the use of the mouse wheel for modifying the event's volume and fades. 3 (not something to change frequently I imagine)
If Enabled, event gain is modified in 1dB 

steps. Fades are adjusted in steps dictated 
Audio - When Recording Wave 

Files Larger than 4 GB
Switches between "Split Files" and "Use RF64 Format" options for what to do when recording 
files larger than 4 GB.

3 (not something to change frequently I imagine)

Control Room - Auto Disable 
Talkback Mode

Switches between 3 options for auto disabling the talkback mic. "No Auto Disable" (talkback 
mic always on), "In Record" (talkback mic off), "In Play and Record" (talkback mic off)

7

Control Room - Dim Cue during 
Talkback

Activates/Deactivates dimming cues during talkback. 7 Don't forget to set Talk Dim Level!

Control Room - Exclusive Device 
Ports for Monitor Channels

Activates/Deactivates the option for exclusive device ports for monitor channels. When 
activated, you cannot assign the same device output to two monitor channels. Each monitor 
channel will have to use a unique output.

0
I can't see the point of this key command. 

I mean, you have to re-assign the 
connections when you toggle this 

Control Room - Show Control 
Room Volume in Transport Panel

Activates/Deactivates controlling the big red knob of the "Main" section of the Control Room 
from the transport bar. When activated it's the red knob being controlled, when deactivated 
it's the stereo out.

You may need to click and drag on the 
Audio Activity & Levels section of the 

Transport Bar for the control "triangle" to 
show.

Control Room - Use Phones 
Channel as Preview Channel

Activates/Deactivates using Phones as the preview channel. 10

Controls - Knob Mode Cycles between "Circular", "Relative Circular", and "Linear" modes for all knobs. 3 (not something to change frequently I imagine)

Controls - Slider Mode Cycles between "Jump", "Touch", "Ramp", and "Relative" modes for all sliders. 3 (not something to change frequently I imagine)

Controls - Value Box/Time 
Control Mode

Cycles between "Text Input on Left-Click", "Increment/Decrement on Left/Right-Click", and 
"Increment/Decrement on Left-Click and Drag" for all value boxes/time controls.

3 (not something to change frequently I imagine)

Editing - 'Edit Solo'/'Record in 
MIDI Editors' Follow Focus

Activates/Deactivates. When deactivated, pressing 'Record in Editor' will keep doing its job, 
regardless of focus. When activated, pressing 'Record in Editor' and then changing focus (by 
clicking in the project window for instance) will de-activate 'record in editor'

7 depending



Editing - Auto Select Events 
under Cursor.

Activates/Deactivates. When activated, positioning the cursor will automatically select all 
events under it.

4
This is a duplicate entry. Also exists in 
Edit>Auto Select Events under Cursor.

Editing - Cycle Follows Range 
Selection

Activates/Deactivates. When activated: If you make a range selection, the left and right 
locators will follow, and take positions on the left and on the right of the range, respectively. 
When deactivated: Range selections don't affect the locators.

8
An easy way to not care about whether a 
command would work with a range or a 

loop (cycle)?

Editing - Default Track Time Type
Cycles between "Musical", "Time Linear", and "Follow Transport Main Display". When you then 
create a new track, it will use the relevant Time Base.

5

Editing - Delete Overlaps
Activates/Deactivates. When activated: Moving an audio event/midi part so that it overlaps 
another one will delete the overlapped area. 

7
Overlapping that happens due to 

recording does not delete overlaps 
immediately. You must move the 

Editing - Display Warning before 
Deleting Non-Empty Tracks

Activates/Deactivates. When activated, trying to delete any track  that is not empty will display 
a warning, and require confirmation.

3 (not something to change frequently I imagine) We can always undo deletion of a track.

Editing - Lock Event Attributes
Cycles through "Position", "Size", "Position + Size", "Other", "Position + Other", "Size + Other", 
"Position + Size + Other". All these determine which attributes of the events will be locked 
when you lock them.

7
Position: No moving the event

Size: No resizing the event
Other: Fade Handles, Event Gain

Editing - Parts Get Track Names Activates/Deactivates. When activated, parts on a track will automatically get the track's name. 7

Editing - Quick Zoom
Activates/Deactivates. When activated, the contents of parts/events are redrawn when you 
stop changing the zoom.

7 I don't notice much of a difference.(?)

Edit - Select Track on Background 
Click

Activates/Deactivates. When activated, clicking in empty space between parts/events of the 
same track will select the track.

5
Using this preference together with 

"Editing - Track Selection Follows Event 
Editing - Track Selection Follows 

Event Selection
Activates/Deactivates. When activated, selecting an event will also select the track it's on. 5

Using this preference together with 
"Editing - Select Track on Background 

Editing - Use Up/Down 
Navigation Commands for 

Selecting Tracks only

Activates/Deactivates. When activated, the Up/Down keys will be reserved for selecting tracks 
only.

3 (not something to change frequently I imagine)

Editors - Double-click Destination
Toggles between "Double-click opens Editor in a Window" and "Double-click opens Editor in 
Lower Zone". This is what will happen when you double click on a part/event.

7

Editors - Editor Content Follows 
Event Selection

Activates/Deactivates. When activated: If you have an Editor open and select a different event, 
the editor will now show/edit the newly selected event.

4

Editors - Open Command 
Destination

Toggles between "Open Editor Commands Open Editors in a Window" and "Open Editor 
Commands open Editors in Lower Zone". This is what will happen when you give the "Open 
Editor" command.

7

Editors - Use Drum Editor when 
Drum Map is assigned

Activates/Deactivates. When activated: Having a drum map assigned on track, if you give the 
"Open Editor" command, the drum Editor will open instead of the default.

3 (not something to change frequently I imagine)

Event Display - Hide Truncated 
Event Names

Activates/Deactivates. When activated: Overly long part names (i.e. extending beyond the 
actual length of the part) will be hidden.

5



Event Display - Show Event 
Names

Activates/Deactivates. When deactivated, event/part names are hidden. 9

Event Display - Show Overlaps
Cycles between "Show Overlaps: Always", "Show Overlaps: On Mouse Over" and "Show 
Overlaps: Never"

6

I can't figure out how "On Mouse Over" 
works. I always see the overlaps ("zebra 

strip"), be it "On Mouse Over" or 
"Always". I would expect that "On Mouse 

Event Display - Smallest Track 
Height To Show Data

Cycles between "Minimal", "One Row", "Two Rows", "Three Rows". This preference sets the 
minimum track height needed for events to show waveforms and MIDI parts to show 
lines/blocks/their default data.

6

Event Display - Smallest Track 
Height to Show Name

Cycles between "Minimal", "One Row", "Two Rows", "Three Rows". This preference sets the 
minimum track height needed for events/parts to show their names.

6

Folders - Show Data on Folder 
Tracks

Cycles between "Always Show Data", "Never Show Data", "Hide Data When Expanded". 
Controls if and when the Folder Track will show data.

6

Folders - Show Event Details
Activates/Deactivates. When activated (and "Folders - Show Data on Folder Tracks" is NOT set 
to "Never Show Data"), the folder track will show the data of the tracks included (waveforms, 
midi blocks etc.).

6

General - Auto Save Activates/Deactivates. 4
General - Open Projects in Last 

Used View
Cycles between "Never", "Only External Projects" and "Always". Determines what windows 
layout will be used when opening projects.

4

General - Run Setup on Create 
New Project

Activates/Deactivates. When activated, creating a new project will bring up the Project Setup 
Window.

5

General - Show Tips
Activates/Deactivates. This controls if explanatory tooltips are displayed when the mouse 
cursor rests over a control.

5

General - Use Hub
Activates/Deactivates. When activated, giving the command for a new project will bring up the 
Hub.

5

MediaBay - Allow Editing in 
Results List

Activates/Deactivates. 3

MediaBay - Scan Folders Only 
When MediaBay is Open

Activates/Deactivates. 3

MediaBay - Scan Unknown File 
Types

Activates/Deactivates. 3

MediaBay - Show File Extensions 
in Results List

Activates/Deactivates. 3

Metering - Map input Bus 
Meering to Audio Track (in Direct 

Monitoring)
Activates/Deactivates. 5

MIDI - Add Latency to MIDI-Thru 
Processing

Activates/Deactivates. When activated, latency is introduced to each note played in real time. 5



MIDI - ASIO Latency 
Compensation Active by Default

Activates/Deactivates. 5

MIDI - Audition through MIDI 
Inserts/Sends

Activates/Deactivates. When activated, the editor's acoustic feedback includes MIDI 
Sends/Inserts, allowing us to layer sounds.

7

MIDI -Insert Reset Events after 
Record

Activates/Deactivates. When activated, a reset message is insert at the end of each recorded 
part, that resets controllers.

6

MIDI - Legato Mode: Between 
Selected Notes Only

Activates/Deactivates. 6

I expected this command to connect to 
the Inspector>Editor>Length>Between 

Selected

It is not connected. As this is a 
preference, it sort of makes sense, yet the 
same function mentioned above does not 

MIDI - MIDI Latency Mode Cycles between "Low", "Normal", "High". 5
MIDI - MIDI Thru Active Activates/Deactivates 7

MIDI - Never Reset Chased 
Controllers

Activates/Deactivates 5

MIDI - Part Data Mode
Cycles through "Lines", "Scores", "Drums", "Blocks" and "No Data". Affects how MIDI data are 
depicted on a track.

8

MIDI - Record-Enable allows 
MIDI Thru

Activates/Deactivates 4

MIDI -Replace Recording in 
Editors

Cycles through "None", "All" and "Controller". 7

MIDI - Reset on Stop Activates/Deactivates. 3 (not something to change frequently I imagine)

MIDI - Select Controllers in Note 
Range: Use Extended Note 

Context

Activates/Deactivates. When deactivated: If you have a CC extend beyond an event's (note's) 
duration and you select the event, only the CC nodes exactly matching the note's duration will 
be selected. When activated, if the CC continues beyond the duration of the note, this extra 
data will be selected when you select the note.

4

MIDI - Show Controllers
Activates/Deactivates. When activated, the MIDI part in the project window will also depict 
CCs, and not only notes.

4

MIDI - Snap MIDI Parts to Bars

Activates/Deactivates. When activated: When you are recording MIDI and you stop recording, 
the MIDI part created will be extended to start/end on the start of a bar. When deactivated: 
The MIDI part will have it start at where recording began, and its end at where recording 
stopped.

3 (not something to change frequently I imagine)

MIDI - Split MIDI Controllers

Activates/Deactivates. When activated: If you split a MIDI part in the project window, this 
preference will make it so that the new part gets a CC data node at its start (if the value was 
different than 0). When deactivated: The controller will not get a data node at the start. (and 
playback oddities may ensue if you throw away the first part that had the CC value leading into 
the the second parts value.)

3 (not something to change frequently I imagine)
I cannot imagine why someone would 

want to keep this preference deactivated. 
(?)



MIDI - Split MIDI Events

Activates/Deactivates. Similar as above. When activated, splitting a MIDI part in the project 
window at the middle of an event, will make it so the event is also split. When deactivated, 
splitting a MIDI part at the middle of an event, will make it so the event is "truncated" at the 
position of the split, and no new event is created in the part on the right.

3 (not something to change frequently I imagine)

Plug-ins - Create MIDI Track 
when Loading VSTi

Cycles between "Always ask to", "Always", "Do not". Determines if a MIDI track will be created 
when you load a VSTi from the F11 menu.

3 (not something to change frequently I imagine)
"Always ask" does not seem to work over 
here. Maybe a long time ago I was asked 

Plug-ins - Open Effect Editor after 
Loading It

Activates/Deactivates. When activated, loading a plug-in will immediately bring up its window 
(GUI).

8

If you are planning on creating 10 
instances of "Mystic" for example, it's a 
good idea to deactivate this preference 

before the batch creation. Even if you can 
Plug-ins - Plug-in Editors "Always 

on Top"
Activates/Deactivates. Per manual: "Always shows the control panels for effect plug-ins and 
VST instruments on top of other windows."

8?
? Well, not working quite as I would 

expect here. ?

Plug-ins - Suspend VST 3 plug-in 
processing when no audio signals 

are received

Activates/Deactivates. The troublesome preference. Steinberg advised to keep this off until 
further notice (at the time of 10.5.20). When activated, VST 3 plug-ins suspend their processing 
(thus improving performance and reducing cpu load) when no audio is passing through.

3 (not something to change frequently I imagine)

Plug-ins - Synchronize Plug-in 
Program Selection to Track 

Selection

Activates/Deactivates. When Activated: If you have a multitimbral instrument like Halion SE 
and you are feeding it from many midi tracks, navigating the project window, going from MIDI 
track 1 to MIDI track 2 will move the respective sound slots in the plug-in's window.

3 (not something to change frequently I imagine)

Plug-ins - Warn before Removing 
Modified Effects

Activates/Deactivates. Well explained. When activated, if you try to unload (throw away) a plug-
in that you have previously tweaked, you will be warned and asked to confirm the removal of 
the plug-in. When deactivated, the plug-in will be removed swiftly without warning.

3 (not something to change frequently I imagine)

Project & MixConsole - Deep 
Track Folding

Activates/Deactivates. When activated: Toggling selected track (From Project>Track Folding) 
will expand/reduce ALL subfolders contained in the selected folder track. When deactivated: 
Only the root folder will be toggled.

4 depending

Project & MixConsole - Enable 
Record on Selected Audio Track

Activates/Deactivates. When activated: The selected audio track will be automatically record-
enabled.

3 (not something to change frequently I imagine)

Project & MixConsole - Enable 
Record on Selected MIDI Track

Activates/Deactivates. When activated: The selected MIDI track will be automatically record-
enabled.

3 (not something to change frequently I imagine)

Project & MixConsole - Enable 
Solo on Selected Track

Activates/Deactivates. When activated: The selected track will be Soloed. 7 depending

Project & MixConsole - Enlarge 
Selected Track

Activates/Deactivates. When activated: The selected track will be made bigger than the rest. 3 (not something to change frequently I imagine)
Duplicate key command. Also in 

Edit>Enlarge Selected Track.



Project & MixConsole - Scroll to 
Selected Track

Activates/Deactivates. When activated: If you select a track in the project window, the 
MixConsole will scroll so that the selected channel is visible. Likewise, selecting a channel in the 
MixConsole will cause the project to scroll so that the selected track is visible.

3 (not something to change frequently I imagine)

Project & MixConsole - Select 
Channel/Track on Edit Settings

Activates/Deactivates. When activated: When you click on the "e" button on a track/channel, it 
will be selected.

3 (not something to change frequently I imagine)

Project & MixConsole - Select 
Channel/Track on Solo

Activates/Deactivates. When activated: When you click Solo on a track/channel, it will be 
selected.

3 (not something to change frequently I imagine)

Project & MixConsole - Sync 
Selection in Project Window and 

MixConsole

Activates/Deactivates. When activated: Selecting a track in the project window will select the 
corresponding channel in the MixConsole, and vice versa.

8

Record - Deactivate Punch In on 
Stop

Activates/Deactivates. Self-explanatory. When activated: Pressing stop will deactivate punch in. 
Secures one-off punches, eliminates the need to micromanage punch in 
activation/deactivation.

3 (not something to change frequently I imagine)

Record - Stop after Automatic 
Punch Out

Activates/Deactivates. Self-explanatory. When activated: If Punch Out is activated, when 
record reaches that point, Stop will be pressed. In the same vein as above, it makes for more 
focused one-off punches.

3 (not something to change frequently I imagine)

Scrub - Use High Quality Scrub 
Mode

Activates/Deactivates. Per manual: Enables effects for scrubbing and uses a higher resampling 
quality. However, scrubbing will be more demanding on the processor.

3 (not something to change frequently I imagine)

Scrub - Use Inserts While 
Scrubbing

Activates/Deactivates. Self-explanatory. 3 (not something to change frequently I imagine)

Tools - Select Tool: Show Extra 
Info

Activates/Deactivates. When activated, the select tool is accompanied everywhere by a tooltip 
that shows the part's name and the time position over which the mouse cursor hovers.

5

Tools - Show Horizontal Cross-
Hair Cursor Line

Activates/Deactivates. When activated, the draw, split, and line tools will get a horizontal line, 
forming a crosshair at the exact position of the mouse cursor's edge.

3 (not something to change frequently I imagine)

Tools - Show Notification when 
Switching Tool Mode with Key 

Command

Activates/Deactivates. When activated, a notification will be shown in the middle of the screen 
every time you switch the modes of a tool with a key command.

3 (not something to change frequently I imagine)

Tools - Show Toolbox on Right-
Click

Activates/Deactivates. When activated, right clicking will bring up the toolbox. When 
deactivated, it will bring up the "regular" right click menu, which has the tools one level deep, 
but also more contextual functions.

3 (not something to change frequently I imagine)
An infamous preference, due to the fact 
that the right click menu available now 
has seen some pruning, and users want 

Tools - Show Vertical Cross-Hair 
Cursor Line

"Changes", does not inform of state. Well, when activated, the draw, split and line tools will get 
a vertical line, forming a crosshair at the exact position of the mouse cursor's edge.

3 (not something to change frequently I imagine)

Tools - Zoom Tool Standard 
Mode: Horizontal Zooming Only

Activates/Deactivates. When activated, using the Zoom Tool will only allow Horizontal 
Zooming.

3 (not something to change frequently I imagine)



Track & MixConsole Channel 
Colors - Auto Track/Channel 

Color Mode

Cycles between "Use Track's Default Color", "Use Previous Track Color", "Use Previous Track 
Color +1", "Use Last Applied Color", "Use Random Track Color". All these determine what color 
the next created track shall be.

6 depending

Transport - Clicking Locator 
Range in Upper Part of the Ruler 

Activates Cycle

Activates/Deactivates. When activated, clicking on the upper part of the ruler between the left 
and right locators will activate the "cycle" (loop)

3 (not something to change frequently I imagine)

Transport - Locate when Clicked 
in Empty Space

Activates/Deactivates. When activated, clicking in empty space in the project window the move 
the cursor to the click's position.

3 (not something to change frequently I imagine)
People are asking for this feature to be 

extended to the MIDI editors.

Transport - Playback Toggle 
Triggers Local Preview

Per manual: Allows you to use Space on your keyboard to start/stop local playback of the 
selected file in the Sample Editor or the Pool. When the Sample Editor is not open or when 
there is no audio file selected in the Pool, Space still toggles the global project playback.

3 (not something to change frequently I imagine)

Transport - Return to Start 
Position on Stop

Activates/Deactivates. Self-explanatory. When activated, pressing stop will return the cursor to 
the start of the project.

3 (not something to change frequently I imagine)

Transport - Show Timecode 
Subframes

Activates/Deactivates. Self-explanatory. When activated, subframes will show too for 
timecode. (It goes without saying that a ruler must show timecode for this to work.)

3 (not something to change frequently I imagine)

Transport - Stop Playback while 
Winding

Activates/Deactivates. Self-explanatory. When activated, if you press rewind or forward while 
the project is playing, stop will be pressed, and when you finish winding you'll need to press 
play again. When deactivated, you can wind while the project is playing, and once you cease 
winding, playback will resume.

3 (not something to change frequently I imagine)

Transport - Zoom while Locating 
in Time Scale

Activates/Deactivates. Self-explanatory. When activated, clicking and dragging up/down on the 
ruler will zoom out/in respectively.

3 (not something to change frequently I imagine)

VariAudio - Inhibit warning when 
applying Offline Processes

Per manual: Inhibits the message that warns you when you apply offline processes to audio 
material that is used in several places in the project.

3 (not something to change frequently I imagine)

VariAudio - Inhibit warning when 
changing the Sample Data

Per manual: Inhibits the message that warns you when you modify audio material that is used 
in several places in the project.

3 (not something to change frequently I imagine)

Video - Extract Audio on Import 
Video File

Activates/Deactivates. Self-explanatory. When activated, importing a video file will extract the 
audio too.

3 (not something to change frequently I imagine)

VST - Activate 'Link Panners' for 
New Tracks

Activates/Deactivates. When activated: If you create a new track, the pan of its sends will 
automatically follow the panner of thechannel itself. When deactivated, you have to set the 
sends pan manually.

3 (not something to change frequently I imagine)

VST - Auto Monitoring
Cycles between "Manual", "While Record-Enabled", "While Record Running" and 
"Tapemachine Style".

4

VST - Connect Sends 
Automatically for Each Newly 

Created Channel

Activates/Deactivates. When activated: If you have FX tracks created, and then you create 
audio/instrument/sampler tracks, those will have their sends automatically connected to the 
existing FX tracks.

3 (not something to change frequently I imagine)

VST - Default Send Level Cycles between "0dB", "-6dB", "-12dB", "-ꝏdB". 3 (not something to change frequently I imagine)



VST - Default Stereo Panner 
Mode

Cycles between "Stereo Dual Panner (Remote Control Devices Only)", "Stereo Combined 
Panner", "Stereo Balance Panner"

3 (not something to change frequently I imagine)

VST - Do Not Connect 
Input/Output Busses When 
Loading External Projects

Activates/Deactivates. Per manual: Prevents connecting input and output busses to the ASIO 
ports of your system when loading external projects.

3 (not something to change frequently I imagine)

VST - Group Channels: Mute 
Sources as well

Activates/Deactivates. When activated: Muting a group channel will press mute on the source 
channels too.

3 (not something to change frequently I imagine)

VST - Instruments use 
Automation Read All and Write 

All

Activates/Deactivates. When activated, pressing the "Activate/Deactivate Read (or Write) for 
All Tracks" will affect instruments too.

0
? It doesn't seem to work. Activated or 
Deactivated, instruments still get the R 

and W when giving the command for all 

VST - Mute Pre-Send when Mute Activates/Deactivates. When activated, muting a track will also mute its "pre" sends. 0
? It doesn't seem to work. Activated or 
Deactivated, the sends don't go to their 

VST - Warn on Processing 
Overloads

Activates/Deactivates. When activated, when a cpu overload/audio dropout is detected, a 
message will pop up where you must confirm to continue.

3 (not something to change frequently I imagine)

Preset

Next Loads the next preset, without opening the preset browser. 8
Mind the selection. When an instrument 
track is selected in the project window, it 

Open Browser Opens the preset browser when a plug-in is in focus. 8 See above.
Previous Loads the previous preset, without opening the preset browser. 8 See above.

Process
Directly applies (using Direct Offline Processing) the relevant Process on the selected audio 
event(s).

8

Process Logical Preset Directly applies the relevant Logical Preset. 8

Process
Directly applies (using Direct Offline Processing) the relevant Plug-in on the selected audio 
event(s).

8

Process Project Logical Preset Directly applies the relevant Project Logical Preset. 8

Project

Auto Fades Settings
Brings up the "Auto Fades - Project" window, where we can select if auto fades will occur, and 
adjust their curves.

5 depending (In Project menu)

Beat Calculator
Brings up the Beat Calculator window, where we can tap a tempo and insert it into the Tempo 
Track.

7

Bring To Front Brings the Project window to the front, and gives it focus. 10 (I have it assigned to Alt Shift U)
Colors Alt Shift S Brings up the Project Colors Setup window. 10

Divide Track List Creates/Removes a line that divides the project window in two rows. 4 (you need the mouse to resize the divider anyway)

Duplicate Tracks Self-explanatory. 3 (right click menu)
Folding: Fold Tracks Closes the selected folder(s). 6 depending

Folding: Toggle Selected Track Opens/Closes ONE selected folder. 7 depending

Folding: Toggle Tracks Opens/Closes ALL folders. 7 depending
Folding: Unfold Tracks Opens the selected folder(s). 6 depending



Move Selected Tracks to New 
Folder

Self-explanatory. 8 depending

Notepad Opens the Project Notepad 2-8 depending
Open Browser Ctrl B Opens the Project Browser window. 10
Open Layout… Opens the "Open Layout" window for scores. 8 depending (Scores Menu)
Open Markers Ctrl M Brings up the Markers window 10

Open Pool Ctrl P Brings up the Pool 10
Open Tempo Track Ctrl T Brings up the Tempo Track 10

Remove Empty Tracks Self-explanatory. If a track contains no data, it will be removed. 7 depending
Remove Selected Tracks Shift Del Self-explanatory. 10
Select Track: Add Next Adds the next track to the selection. 10 (I have it assigned to Ctrl Alt Shift =)
Select Track: Add Prev Adds the previous track to the selection. 10 (I have it assigned to Ctrl Alt Shift -)

Select Track: Next Selects the next track. 10 (I have it assigned to Ctrl Alt =)
Select Track: Prev Selects the previous track. 10 (I have it assigned to Ctrl Alt -)

Set Timecode
Brings up the Set Timecode at Cursor window, where we can choose the start time of the 
Timecode.

4 depending

Set Track/Event Color Alt Shift C
Brings up the Colorize Select Tracks Panel, to colorize selected tracks. It remains open, allowing 
to colorize tracks one after the other.

10

Setup Shift S Brings up the Project Setup window. 10
Tempo Detection… Brings up the Tempo Detection Panel. A selection must be made first. 6 depending

Track Controls Settings
Brings up the Track Controls Settings window, in which we can customize the information and 
buttons shown on each track type.

6 depending

Track Preset: Next Loads the next Track Preset. 5 depending

The presets actually load when giving this 
command. I got a "Serious problem has 
occurred" after giving this command 4-5 

times. I guess it would be wiser if the 

Track Preset: Open Browser
Opens the Track Preset Browser, to choose a Track Preset for the selected track. If many tracks 
are selected, only the first is affected.

5 depending

Track Preset: Previous Loads the previous Track Preset. 5 depending

The presets actually load when giving this 
command. I got a "Serious problem has 
occurred" after giving this command 4-5 

times. I guess it would be wiser if the 

VST Preset: Next Loads the next VST Preset (for Instruments) 5 depending
The presets actually load when giving this 
command. I didn't get a crash using this 

command like with "Track Preset: 

VST Preset: Open Browser
Opens the VST Preset Browser, to choose a VST Preset for the selected track. If many tracks are 
selected, only the first is affected.

5 depending

VST Preset: Previous Loads the previous VST Preset (for Instruments) 5 depending
The presets actually load when giving this 
command. I didn't get a crash using this 

command like with "Track Preset: 
Quantize Category

AudioWarp Quantize On/Off Activates/Deactivates AudioWarp Quantize 4 depending



Auto Quantize On/Off Activates/Deactivates Auto Quantize. (MIDI only) 4 depending

Create Groove Quantize Preset Creates a Groove Quantize Preset from the selection. 4 depending

Freeze MIDI Quantize
Per manual: Makes the start and end positions of MIDI events permanent. This function is 
useful in situations where you want to quantize a second time, based on the current quantized 
positions rather than the original positions.

4 depending

Iterative Quantize On/Off Activates/Deactivates Iterative Quantize. 4 depending
Quantize Q Quantizes. 10

Quantize MIDI Event Ends Quantizes the ends of MIDI Events. Found in Inspector>Editor>Quantize Section. 4 depending
Quantize MIDI Event Lengths Quantizes the lengths of MIDI Events. Found in Inspector>Editor>Quantize Section. 4 depending

Quantize Panel Brings up the Quantize Panel 9

Reset Quantize
Resets Quantize. If you have used "Freeze MIDI Quantize",  this command will NOT take you 
back before the Freeze.

4 depending

Select Next Quantize Selects the Next Quantize value. 8 depending
Select Prev Quantize Selects the Previous Quantize value. 8 depending
Set Quantize to 1th Directly sets the Quantize value to a Whole note. 9
Set Quantize to 2th Directly sets the Quantize value to a Half note. 9
Set Quantize to 4th Directly sets the Quantize value to a Quarter note. 9
Set Quantize to 8th Directly sets the Quantize value to an Eighth note. 9

Set Quantize to 16th Directly sets the Quantize value to a Sixteenth note. 9
Set Quantize to 32th Directly sets the Quantize value to a Thirty-second note. 9
Set Quantize to 64th Directly sets the Quantize value to a Sixty-fourth note. 9

Set Quantize to 128th Directly sets the Quantize value to a Hundred-and-Twenty-Eighth note. 9
Toggle Quantize Dotted Adds/Removes dot to/from the current quantize value. 9
Toggle Quantize Triplet Modifies current quantize value to be triplets. 9

Render in Place

Render (with Current Settings) Directly renders the selection with the current render settings. 10

Render Settings…
Brings up the Render Tracks window, where we can change the current render settings, and 
render the selection if we want.

6

Sample Editor
Bypass Warping Bypasses the AudioWarp Section of the Inspector>Editor (Sample Editor) 4 depending

Reanalyze Audio Reanalyzes the audio to prepare it for VariAudio Editing.
6 depending (hidden a bit deep, in 

Inspector>Editor>VariAudio>Functions drop-down 
menu)

VariAudio - Bypass VariAudio Bypasses the VariAudio Section of the Inspector>Editor 4 depending

VariAudio - Extract MIDI (no 
Dialog)

Directly Extracts MIDI when Editing VariAudio, using the current settings for the extraction. 6 depending

VariAudio - Extract MIDI…
Brings up the Extract MIDI window, where the settings for extracting MIDI from Audio are 
made.

4 depending



VariAudio - Quantize Pitch
Quantizes Pitch. I think it's like dragging the quantize pitch slider to 100%, except when using 
this key-command, the Quantize Pitch slider is greyed out.

6 depending

VariAudio - Reset All Changes Resets All Changes for selection. 
6 depending (hidden a bit deep, in 

Inspector>Editor>VariAudio>Functions drop-down 
menu)

VariAudio - Reset Formant Shift 
Changes

Resets changes made to the "Shift Formant" slider.
6 depending (hidden a bit deep, in 

Inspector>Editor>VariAudio>Functions drop-down 
menu)

VariAudio - Reset Pitch Changes Resets changes made to the "Quantize Pitch" slider.
6 depending (hidden a bit deep, in 

Inspector>Editor>VariAudio>Functions drop-down 
menu)

VariAudio - Reset Pitch Curve 
Changes

Resets changes made to the "Straighten Curve" slider.
6 depending (hidden a bit deep, in 

Inspector>Editor>VariAudio>Functions drop-down 
menu)

VariAudio - Reset Volume 
Changes

Resets changes made to the "Volume" slider.
6 depending (hidden a bit deep, in 

Inspector>Editor>VariAudio>Functions drop-down 
menu)

VariAudio - Reset Warp Changes Resets changes made to the segments' starts and ends.
6 depending (hidden a bit deep, in 

Inspector>Editor>VariAudio>Functions drop-down 
menu)

VariAudio - Show MIDI Reference 
Track

Shows/Hide the MIDI reference track assigned. 4

VariAudio - Toggle Pitch Snap 
Mode

Cycles between "Absolute", "Relative", and "Off" for the Pitch Snap Mode. 4 depending

VariAudio - Toggle Smart Control 
Mode

Toggles between "Default" and "All" Smart Controls. 4 depending

Score Align Elements
Bottom Aligns symbols horizontally to the bottom. 5 depending (In Scores>Align Elements)

Center Horizontally Aligns symbols to the center horizontally. 5 depending (In Scores>Align Elements)
Center Vertically Aligns symblols to the center vertically. 5 depending (In Scores>Align Elements)

Dynamics Aligns only dynamics. 5 depending (In Scores>Align Elements)
Left Aligns symbols to the left. 5 depending (In Scores>Align Elements)

Right Aligns symbols to the right. 5 depending (In Scores>Align Elements)
Top Aligns symbols to the top. 5 depending (In Scores>Align Elements)

Score Functions
50% ? I suspect this is Page Mode zoom, but it doesn't do anything. ? 0 ?
75% ? I suspect this is Page Mode zoom, but it doesn't do anything. ? 0 ?

100% ? I suspect this is Page Mode zoom, but it doesn't do anything. ? 0 ?
120% ? I suspect this is Page Mode zoom, but it doesn't do anything. ? 0 ?
200% ? I suspect this is Page Mode zoom, but it doesn't do anything. ? 0 ?
300% ? I suspect this is Page Mode zoom, but it doesn't do anything. ? 0 ?
400% ? I suspect this is Page Mode zoom, but it doesn't do anything. ? 0 ?



600% ? I suspect this is Page Mode zoom, but it doesn't do anything. ? 0 ?
Auto Group Notes Automatically groups notes. (Connects stems) 7 depending

Auto Layout Brings up the Auto Layout window. 7 depending
Auto Layout: Bars and Staves Directly applies Auto Layout with the Bars and Staves option. 7 depending
Auto Layout: Hide All Empty 

Staves
Directly applies Auto Layout with the "Hide Empty Staves>All Staves" option. 7 depending

Auto Layout: Hide Empty Staves Directly applies Auto Layout with the "Hide Empty Staves" option. 7 depending

Auto Layout: Move All Bars Directly applies Auto Layout with the "Move Bars>All Staves" option. 7 depending
Auto Layout: Move All Staves Directly applies Auto Layout with the "Move Staves>All Staves" option. 7 depending

Auto Layout: Move Bars Directly applies Auto Layout with the "Move Bars" option. 7 depending
Auto Layout: Move Staves Directly applies Auto Layout with the "Move Staves" option. 7 depending
Auto Layout: Optimize All Directly applies Auto Layout with the "Optimize All" option. 7 depending

Auto Layout: Spread All Pages Directly applies Auto Layout with the "Spread All Pages" option. 7 depending

Auto Layout: Spread Pages Directly applies Auto Layout with the "Spread Page" option. 7 depending

Brillenbass…
I never encountered this terminology before. Brings up a "Grouping" window to select the 
tremolo value, and then builds a tremolo between the selected notes.

7 depending

Build Accelerando…
Brings up a "Grouping" window to select the starting and end values, then creates a feathered 
"accelerando" beam.

4 depending

Build N-Tuplet… Brings up the Tuplets window, to build the desired tuplet. 10

Build Repeat…
Brings up a "Grouping" window to select the value, and then applies single-note tremolos to 
the selected notes.

10

Build Trill… Brings up a "Build Trill" window, to build a trill. 10
Clear Bar Clears the selected bars. 7 depending

Convert to Grace Note Converts the selected notes to grace notes. 10

Display Markers
Displays Markers in the score. (You need to have an active marker track. You can fill in the 
description field of the markers, and it will automatically be used.)

7 depending

Enharmonic Shift: # Respells the selected notes enharmonically using sharps, if possible. 3 depending
Enharmonic Shift: ## Respells the selected notes enharmonically using double sharps, if possible. 3 depending
Enharmonic Shift: () Encloses accidentals in parentheseis. 3 depending
Enharmonic Shift: ? Spells all accidentals for selected notes. (All accidentals, even naturals.) 3 depending
Enharmonic Shift: b Respells the selected notes enharmonically using flats, if possible. 3 depending

Enharmonic Shift: bb Respells the selected notes enharmonically using double flats, if possible. 3 depending
Enharmonic Shift: no (hide) Hides all accidentals for the selected notes. 3 depending

Enharmonic Shift : off 
(automatic)

Turns off enharmonic shift and returns to the automatic enharmonic spelling. 3 depending

Explode
Brings up an Explode winodw, to adjust the settings for the explosion. (If we have more than 
one notes occurring simultaneously in one voice, we can use explode to  either send them to 
polyphonic voices, or different tracks. Kind of like Dissolve Part of MIDI)

6 depending

Extract Voices Like above, but tracks are created for each voice assigned. 6 depending



Flip Flips stems. 10

Font Settings, Set 1 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 2 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 3 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 4 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 5 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 6 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 7 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 8 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 9 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 10 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 11 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 12 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 13 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 14 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 15 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Font Settings, Set 16 - x
Applies set "x's" font settings to the selected text. You must first create a new set from 
Scores>Settings>Project, Font Settings>Attribute Sets

10

Force Update Forces a redraw of the whole page. 4

Get Info
Multifunctional key. Like double-clicking on an element. Use it on a clef, takes you to Edit clef. 
Use it on a bar-line, takes you to the repeat bar lines window. Use it on a note-head, takes you 
to the Set Note Info window. You get the picture.

10

Group Notes
Groups the selected notes. The starting note of the selection will be the first of the group and 
have a starting beam, and the note in the end will be the last of the group and have an ending 
beam.

10

Hide Hides/shows the selected element. 10
Insert Slur Inserts a slur over the selected notes. 10



Insert Voice: 1 "Arms" Voice 1. Any notes you draw will belong to Voice 1 10
Insert Voice: 2 "Arms" Voice 2. Any notes you draw will belong to Voice 2 10
Insert Voice: 3 "Arms" Voice 3. Any notes you draw will belong to Voice 3 10
Insert Voice: 4 "Arms" Voice 4. Any notes you draw will belong to Voice 4 10

Insert Voice: Next "Arms" the next Voice. Does NOT cycle back after you reach Voice 4. 7
Insert Voice: Previous "Arms" the previous Voice. Does NOT cycle back after you reach Voice 1. 7

Make Chord Symbols Makes Chord Symbols out of the selected notes. (must be chords, arpeggios don't count) 8 depending

Marker Track to Form
If you have insert any markers, giving this command will put them in the score as rehearsal 
marks, with double barlines under them.

8 depending

Merge All Staves
Merges up to four different staves into one staff, by assigning each staff a voice from 1 to 4. 
(Others call it Implode)

6 depending

Move To String 1
When working with tablature, you can move a note on other strings to string 1. (Provided the 
note exists on the string).

8

Move To String 2
When working with tablature, you can move a note on other strings to string 2. (Provided the 
note exists on the string).

8

Move To String 3
When working with tablature, you can move a note on other strings to string 3. (Provided the 
note exists on the string).

8

Move To String 4
When working with tablature, you can move a note on other strings to string 4. (Provided the 
note exists on the string).

8

Move To String 5
When working with tablature, you can move a note on other strings to string 5. (Provided the 
note exists on the string).

8

Move To String 6
When working with tablature, you can move a note on other strings to string 6. (Provided the 
note exists on the string).

8

Move To String 7
When working with tablature, you can move a note on other strings to string 7. (Provided the 
note exists on the string).

8

Move To String 8
When working with tablature, you can move a note on other strings to string 8. (Provided the 
note exists on the string).

8

Move To String 9
When working with tablature, you can move a note on other strings to string 9. (Provided the 
note exists on the string).

8

Move To String 10
When working with tablature, you can move a note on other strings to string 10. (Provided the 
note exists on the string).

8

Move To String 11
When working with tablature, you can move a note on other strings to string 11. (Provided the 
note exists on the string).

8

Move To String 12
When working with tablature, you can move a note on other strings to string 12. (Provided the 
note exists on the string).

8

Move To Voice 1
Moves selected note(s) to Voice 1, provided staff settings allow. (Polyphonic mode must be on, 
and the respective voices activated)

10

Move To Voice 2
Moves selected note(s) to Voice 2, provided staff settings allow. (Polyphonic mode must be on, 
and the respective voices activated)

10

Move To Voice 3
Moves selected note(s) to Voice 3, provided staff settings allow. (Polyphonic mode must be on, 
and the respective voices activated)

10



Move To Voice 4
Moves selected note(s) to Voice 4, provided staff settings allow. (Polyphonic mode must be on, 
and the respective voices activated)

10

Move To Voice 5
Moves selected note(s) to Voice 5, provided staff settings allow. (Polyphonic mode must be on, 
and the respective voices activated)

10

Move To Voice 6
Moves selected note(s) to Voice 6, provided staff settings allow. (Polyphonic mode must be on, 
and the respective voices activated)

10

Move To Voice 7
Moves selected note(s) to Voice 7, provided staff settings allow. (Polyphonic mode must be on, 
and the respective voices activated)

10

Move To Voice 8
Moves selected note(s) to Voice 8, provided staff settings allow. (Polyphonic mode must be on, 
and the respective voices activated)

10

Number of Bars
Brings up "Number of Bars" window, where we can choose how many bars there will be per 
system in Page Mode.

8

One down
Moves to the next HIGHER Voice. If you have a note in Voice 4 and you give this command, the 
note will go to Voice 3. That's why it's "One down", because 4-1=3. Well.

6

One up
Moves to the next LOWER Voice. If you have a note in Voice 3 and you give this command, the 
not will go to Voice 4. That's why it's "One up", because 3+1=4. Well.

6

Paste Note Attributes

If you copy a note that is marked with say, tenuto, staccato and marcato and then use this 
command on an unmarked note, it will be marked with tenuto, staccato and marcato. Most of 
the attributes included in "Set Note Info" (when double clicking a note) work with this 
command. Pity it doesn't work with whole passages.

8

Position Panel Brings up the Position Info panel. Doesn't close it though. 5

Reset Layout…
Brings up the Reset Layout window. There we must choose what will be reset, and on which 
staves.

6

Score Notes to MIDI
This command will transform the actual MIDI part to be EXACTLY as the score. (Of course this 
about a recorded MIDI performance, which Cubase makes more "readable" with its Display 
Quantize.)

4

Show Bar Repeat Sign Places the "repeat previous bar" musical symbol in the selected bars. 6 depending
Show Chord Track Shows/Hides the Chord Track. 8

Show Regular Notation
If you have a selection transformed to rhythmic notation, you can make it "Show Regular 
Notation" again with this command.

5 depending

Show Rhythmic Notation

Takes a selection and makes it into Rhythmic Notation. What this means is, all notes are 
brought to the same staff line, and have their noteheads change. You can go back to the 
previous state with "Show Regular Notation". All this is just -displaying- information, nothing is 
being actually changed.

5 depending

Spacer and Hidden to Layout
The "Spacer" part is not clear to me. The Hidden to Layout is plain as day. Whatever you've 
hidden, when you give this command it will be moved to the Layout Layer.

5? ?

Verse 1 Moves the selected lyrics to the 1st verse. 7 depending
Verse 2 Moves the selected lyrics to the 2nd verse. 7 depending
Verse 3 Moves the selected lyrics to the 3rd verse. 7 depending



Verse 4 Moves the selected lyrics to the 4th verse. 7 depending
Verse 5 Moves the selected lyrics to the 5th verse. 7 depending
Verse 6 Moves the selected lyrics to the 6th verse. 7 depending

Score Meter Scale

50% Zooms to 50% both in Edit Mode, and Page Mode. 10
In Edit Mode, this key command will 

apply the magnification, but layout will 

75% Zooms to 75% both in Edit Mode, and Page Mode. 10
In Edit Mode, this key command will 

apply the magnification, but layout will 

100% Zooms to 100% both in Edit Mode, and Page Mode. 10
In Edit Mode, this key command will 

apply the magnification, but layout will 

120% Zooms to 120% both in Edit Mode, and Page Mode. 10
In Edit Mode, this key command will 

apply the magnification, but layout will 

200% Zooms to 200% both in Edit Mode, and Page Mode. 10
In Edit Mode, this key command will 

apply the magnification, but layout will 

300% Zooms to 300% both in Edit Mode, and Page Mode. 10
In Edit Mode, this key command will 

apply the magnification, but layout will 

400% Zooms to 400% both in Edit Mode, and Page Mode. 10
In Edit Mode, this key command will 

apply the magnification, but layout will 

600% Zooms to 600% both in Edit Mode, and Page Mode. 10
In Edit Mode, this key command will 

apply the magnification, but layout will 
CM Changes the Page Mode ruler to centimeters. 10

Edit Mode: 50% Zooms to 50% when in Edit Mode only. 10 Unlike the previous key commands, this 
Edit Mode: 80% Zooms to 80% when in Edit Mode only. 10 Unlike the previous key commands, this 

Edit Mode: 100% Zooms to 100% when in Edit Mode only. 10 Unlike the previous key commands, this 
Edit Mode: 150% Zooms to 150% when in Edit Mode only. 10 Unlike the previous key commands, this 
Edit Mode: 200% Zooms to 200% when in Edit Mode only. 10 Unlike the previous key commands, this 

Fit Page In Page Mode, fits the whole page to the screen. In Edit Mode, it tries to do something similar? 10

Fit Width
In Page Mode, fits the width of the page to the screen. In Edit Mode, it tries to do something 
similar?

10

Hide Unused In Edit Mode, Hides Unused staves. 10
Inch Changes the Page Mode ruler to inches. 10
Off Removes the Page Mode ruler. 10
PT Changes the Page Mode ruler to Points. (0,3528mm) 10

Score Symbol Editor
100% Zooms to 100% in the Symbol Editor 6
200% Zooms to 200% in the Symbol Editor 6
400% Zooms to 400% in the Symbol Editor 6
600% Zooms to 600% in the Symbol Editor 6
800% Zooms to 800% in the Symbol Editor 6

Align Bottom Aligns selection in the Symbol Editor to the bottom. 6
Align Center Horizontally Aligns selection in the Symbol Editor in a row, horizontally. 8



Align Center Vertically Aligns selection in the Symbol Editor in a column, vertically. 8
Align Left Aligns the left sides of the selection in the Symbol Editor, vertically. 8

Align Right Aligns the right sides of the selection in the Symbol Editor, vertically. 8
Align Top Aligns the top sides of the selection in the Symbol Editor, horizontally. 8

Bring To Front Brings selection to front. 8

Delete Symbol
Deletes the selected symbol on the left. If you only have one symbol on the left, this command 
will not delete it.

8

Export Symbol… Brings up the "Eport Graphics" (x missing) window, to export the selected symbol. 8

Export User Symbols… Brings up the "Save Palette…" window, to export the whole palette. (all symbols on the left) 8

Flip +90 Flips the current selection 90 degrees clockwise. 8
Flip -90 Flips the current selection 90 degrees anticlockwise. 8
Group Makes the current selection of elements into a group. 10

Import Symbol… Brings up the "Import Graphics" window, to import a symbol. 8

Import User Symbols… Brings up the "Open Palette..." window, to import a whole palette. (all symbols on the left) 8

Mirror horizontal Mirrors selection along the horizontal axis. 10
Mirror vertical Mirrors selection along the vertical axis. (Not working as expected.) 0 ? Not working as expected. ?
New Symbol Starts a new symbol. 8
Send to Back Sends selection to the back. 8

Ungroup
If you have made a selection into a group before, you can disband the group and go back to 
having independent elements with this command.

10

Score Symbol Palettes
All key commands in this category get a 5 

keyworthiness score. If the palettes 
opened AND closed with the key 

Chord Symbols Brings up the "Chord Symbols" palette. 5
Clef Brings up the "Clef" palette. 5

Clef etc. Brings up the "Clef etc." palette. 5
Dynamic Mapping Brings up the "Dynamic Mapping" palette. 5

Dynamics Brings up the "Dynamics" palette. 5

Expression Map
Brings up the "Expression Map" palette. (It goes without saying that you must have assigned an 
expression map.)

5

Favorites Brings up the "Favorites" palette. 5
Form Symbols Brings up the "Form Symbols" palette. 5
Guitar Symbols Brings up the "Guitar Symbols" palette. 5

Keys Brings up the "Keys" palette. 5
Line/Trill Brings up the "Line/Trill" palette. 5

Note Symbols Brings up the "Note Symbols" palette. 5

Note Symbols Editor ? Brings up the "Note Symbols Editor" palette ? ?
In my case, a very very little palette 

window opens, empty. I don't know what 
Other Brings up the "Other" palette. 5

Time Sign Brings up the "Time Sign" palette. 5



User Symbols Brings up the "User Symbols" palette. 5
Words Brings up the "Words" palette. 5
Scores

Auto Group Notes
? This command does nothing for me, neither does it show next to the respective right-click 
menu option. ?

0 ? Broken ?

Find and Replace…
Brings up the "Find and Replace" window, where we can Find and Replace text throughout the 
score.

5

Lyrics from Clipboard
If you have some text copied to the clipboard, you can select a note and give this command to 
insert this text as lyrics, starting on that note.

5

Move to Next Page Moves the selected system to the next page. 10
Move to Previous Page Moves the selected system to the previous page. 10

Page Mode Switches between Page Mode/Edit Mode. 10
Score Editor in Lower Zone: 

Toggle Inspector
? This command does nothing for me. I think it should switch between "Show Symbols" and 
"Show Inspector" in the "Inspector>Editor" drop-down menu. ?

0 ? Broken ?

Settings… Brings up the "Score Settings" window. 10 ? What's the difference with "Staff Setup" 
Staff Setup Brings up the "Score Settings" window. 10 ? What's the difference with "Settings…" ?

Text from Clipboard
If you have some text copied to the clipboard, you can select some text and give this command 
to replace it with the clipboard's text.

5

User Symbols… Directly opens the "User Symbols Editor". 10
Scores Statusbar

Toggle Filter: Bar Handles Self Explanatory. 10
Toggle Filter: Cutflag Self Explanatory. 10

Toggle Filter: Grouping Self Explanatory. 10
Toggle Filter: Hidden Notes Self Explanatory. 10

Toggle Filter: Hide Self Explanatory. 10
Toggle Filter: Layout Tool Self Explanatory. 10

Toggle Filter: Quantize Self Explanatory. 10
Toggle Filter: Split Rests Self Explanatory. 10

Toggle Filter: Stems/Beams Self Explanatory. 10
Set Insert Length

1/ 1 Alt 1 Sets Insert Length to whole note. 10
1/ 2 Alt 2 Sets Insert Length to half note. 10
1/ 4 Alt 3 Sets Insert Length to quarter note. 10
1/ 8 Alt 4 Sets Insert Length to eighth note. 10

1/ 16 Alt 5 Sets Insert Length to sixteenth note. 10
1/ 32 Alt 6 Sets Insert Length to thirty-second note. 10
1/ 64 Alt 7 Sets Insert Length to sixty-fourth note. 10
1/128 Alt 8 Sets Insert Length to hundred-and-twenty-eighth note. 10

Toggle Dotted Alt . Adds/Removes dot to/from the current insert value. 10
Toggle Triplet Alt , Modifies current insert length value to be triplets. 10

Text Size
24 Directly resizes selected text to 24 points. 8



36 Directly resizes selected text to 36 points. 8
48 Directly resizes selected text to 48 points. 8
60 Directly resizes selected text to 60 points. 8
72 Directly resizes selected text to 72 points. 8
84 Directly resizes selected text to 84 points. 8

120 Directly resizes selected text to 120 points. 8
144 Directly resizes selected text to 144 points. 8
Tool

Audio Tempo Definition Tool
In Sample Editor, under Definition, there exists Manual Adjust. That's what the key command 
does.

5

Color Tool Selects the color tool. 4

Combine Selection Tools On/Off Alt Shift 1 Activates/Deactivates the combined Select/Range tools. 10

Comp Tool Selects the comp tool. 8 depending

Curve Tool
Selects the curve tool. Also cycles between the line options "Line", "Parabola", "Sine", 
"Triangle" and "Square".

8 depending

Cut Tool Selects the Cut Notes Tool of the Score Editor. 8 depending
Display Quantize Tool Selects the Display Quantize Tool of the Score Editor. 8 depending

Draw Tool 8 Selects the Draw Tool 10
Drumstick Tool 0 Selects the Drumstick Tool of the Drum Editor. 10

Erase Tool 5 Selects the Erase Tool 10
Export Range Tool Selects the Export Range Tool of the Score Editor. 8 depending

Free Warp Tool
In Sample Editor, under AudioWarp, there exists Free Warp. That's what the key command 
does.

5

Glue Tool 4 Selects the Glue Tool. 10

Hitpoint Tool
In Sample Editor, under Hitpoints, there exists Edit Hitpoints. That's what the key command 
does.

5

Insert Note Tool Selects the Insert Note Tool of the Score Editor. 8 depending
Layout Tool Selects the Layout Tool of the Score Editor. 8 depending
Mute Tool 7 Selects the Mute Tool 10

Next Tool F10 Selects the next tool, depending on which window has focus. 10

When the Score Editor is in the Lower 
Zone, this command will get stuck on the 
Layout Tool, for obvious reasons. Even if 
we manually choose the Cut Notes tool 
that's right next to it, and then give the 

Object Selection Tool 1 Selects the Object Selection Tool. 10
Object Selection Tool: Normal 

Sizing
Directly selects the "Normal Sizing" Mode of the Selection Tool. 10

Object Selection Tool: Sizing 
Applies Time Stretch

Directly selects the "Sizing Applies Time Stretch" Mode of the Selection Tool. 10

Object Selection Tool: Sizing 
Moves Content

Directly selects the "Sizing Moves Content" Mode of the Selection Tool. 10



Play Tool 9 Selects the Play Tool. 10
Pop-up Toolbox Brings up the Pop-up Toolbox at the mouse cursor's position. 5 depending

Previous Tool F9 Selects the previous tool, depending on which window has focus. 10

When the Score Editor is in the Lower 
Zone, this command will get stuck on the 
Export Range, Tools for obvious reasons. 
If we manually choose the Cut Notes tool 

that's right next to it, and then give the 
Range Selection Tool 2 Selects the Range Selection Tool. 10

Score Zoom Tool Selects the Score Zoom Tool. 8 depending
Scrub Tool Selects the Scrub Tool of the Sample Editor. 8 depending
Split Tool 3 Selects the Split Tool. 10

TimeWarp Tool Selects the TimeWarp Tool. 8 depending
Tool 1 Depending on which window has focus, selects  the first tool on the toolbar. 8 depending
Tool 2 Depending on which window has focus, selects  the second tool on the toolbar. 8 depending
Tool 3 Depending on which window has focus, selects  the third tool on the toolbar. 8 depending
Tool 4 Depending on which window has focus, selects  the fourth tool on the toolbar. 8 depending
Tool 5 Depending on which window has focus, selects  the fifth tool on the toolbar. 8 depending
Tool 6 Depending on which window has focus, selects  the sixth tool on the toolbar. 8 depending
Tool 7 Depending on which window has focus, selects  the seventh tool on the toolbar. 8 depending
Tool 8 Depending on which window has focus, selects  the eighth tool on the toolbar. 8 depending
Tool 9 Depending on which window has focus, selects  the ninth tool on the toolbar. 8 depending

Tool 10 Depending on which window has focus, selects  the tenth tool on the toolbar. 8 depending
Trim Tool Selects the Trim Tool of the Key Editor. 8 depending

VariAudioTool
In Sample Editor, under VariAudio, there exists Edit VariAudio. That's what the key command 
does.

8 depending

Zoom Tool 6 Selects the Zoom Tool. 10
Track Versions

Assign Common Version ID Assign a Common Version ID to two or more tracks. 6 depending

Create Lanes from Versions
When a track has more than one versions, this command will create one more version that will 
have all previous versions as lanes on the track.

6 depending

Create Versions from Lanes
When a track has more than one lanes, this command will create as many new versions as 
there are lanes.

6 depending

Delete Inactive Versions of All 
Tracks

A project wide version cleaner. If you have your preferred versions active for all the tracks in 
your project, and you feel that you won't be needing the other versions of the tracks - all of 
them -, you can issue this command and all the other versions will be deleted except the active 
ones.

6 depending

Delete Inactive Versions of 
Selected Tracks

If you have settled on the best version for a track and you feel you won't be needing the other 
versions anymore, you can issue this command and all the other version will be deleted except 
the currently active one.

6 depending

Delete Version Deletes the currently active version. 6 depending
Duplicate Version Ctrl Shift D Duplicates the current version. 10

New Version Ctrl Shift N Creates a New Version. 10



Next Version Ctrl Shift H Activates the next version. 10
Previous Version Ctrl Shift G Activates the previous version. 10
Rename Version Renames the active version. 8 depending

Select Tracks with Same Version 
ID

If you have used "Assign Common Version ID" to some tracks, you can then use this command 
to select them.

6 depending

Transport
Activate External Sync Alt Shift T Activates/Deactivates External Synchronization 10
Activate Metronome C Activates/Deactivates the metronome click. 10

Activate Punch In I Activates/Deactivates Punch In. 10
Activate Punch Out O Activates/Deactivates Punch Out. 10

Audio Record Mode
Cycles through Audio Recording Modes "Keep History", "Cycle History + Replace" and 
"Replace"

7 depending

Auto Quantize in Record MIDI only. Automatically quantizes as you record. 8 depending
Cycle Num / Activates/Deactivates the Cycle (Loop). 10

Enter Left Locator Shift L Takes you straight to the left locator's input field. 10

Enter Locator Range Duration Shift D
Brings up a little panel where you can directly specify the cycle's (loop's, locators' range) 
Duration.

10

Enter Project Cursor Position Shift P Takes you straight to the project cursor's input field. 10

Enter Punch In Position Shift I
Brings up a little panel where you can directly specify the punch in and punch out positions, as 
well as lock the punch in/punch out range to the left/right locators.

10

Enter Punch Out Position Shift O
Brings up a little panel where you can directly specify the punch in and punch out positions, as 
well as lock the punch in/punch out range to the left/right locators.

10

Enter Right Locator Shift R Takes you straight to the right locator's input field. 10

Enter Tempo Shift T
Brings up a little panel where you can set the tempo, the time signature and 
activate/deactivate the tempo track.

10

Enter Time Signature Shift C
Brings up a little panel where you can set the tempo, the time signature and 
activate/deactivate the tempo track.

10

Exchange Left & Right Locator 
Positions

The position of the left locator becomes the position of the right locator, and the position of 
the right locator becomes the position of the left locator.

6 depending

Exchange Time Formats . Exchanges Time Formats between "Bars+Beats" and "Seconds". 10
Fast Forward Shift Num + Self Explanatory. 10
Fast Rewind Shift Num - Self Explanatory. 10

Forward Num + Self Explanatory. 10
Go to Left Locator Num 1 Sends the project cursor to the left locator. 10
Go to Project End Sends the project cursor to the end of the project. (End of the last event) 7 depending
Go to Project Start Num . Sends the project cursor to the very start of the project. 10

Go to Punch In Position Sends the project cursor to the punch in's position. 6 depending
Go to Punch Out Position Sends the project cursor to the punch out's position. 6 depending

Go to Right Locator Num 2 Sends the project cursor to the right locator. 10
Insert Cycle Marker Inserts a cycle marker at the current cycle (loop, locators range). 6 depending

Insert Marker Insert Inserts a marker at the cursor's position. 10
Jog Left Jogs to the left. 6 depending



Jog Right Jogs to the right. 6 depending
Locate Next Event N Sends the project cursor to the next event's start/end. 10

Locate Next Hitpoint Alt N Sends the project cursor to the next hitpoint. 10
Locate Next Marker Shift N Sends the project cursor to the next marker. 10

Locate Previous Event B Sends the project cursor to the previous event's end/start. 10
Locate Previous Hitpoint Alt B Sends the project cursor to the previous hitpoint. 10
Locate Previous Marker Shift B Sends the project cursor to the previous marker. 10

Locate Selection End Sends the project cursor to the selection's end. 10 (I have it next to L, at ;)
Locate Selection Start L Sends the project cursor to the selection's start. 10

Locators to Selection P
Sets the Left Locator to the start of the selection, and the Right Locator to the end of the 
selection.

10

Lock Punch Points to Locators Self-explanatory. Set the Left and Right Locators, and the Punch In/Out Points follow. 9 depending

Lock Record

Giving this command after you've started recording will Lock the record button. This means 
that pressing other keys on the transport (play, stop, rewind, record etc.) will bring up a dialog 
asking you to confirm that you really want to stop recording. Good for making sure recording 
will continue no matter what.

9 depending

Loop Selection Alt P
When you have made a selection and give this command, the locators will be set to the 
selection (like pressing P), cycle will be activated (like pressing Num /), and Start pressed (like 
pressing Space), all in one go!

10

Metronome Setup Brings up the Metronome Setup window. 8 depending

MIDI Cycle Record Mode
Cycles the MIDI Cycle Record Mode between "Mix", "Overwrite", "Keep Last", "Stacked" and 
"Mix-Stacked (No Mute)"

8 depending

MIDI Record Mode Cycle the MIDI Record Mode between "New Parts", "Merge" and "Replace". 8 depending
MIDI Retrospective Record: 

Empty All Buffers
When you play notes on a keyboard without recording, these go into the "buffer". If you wish 
to clean up this buffer at any time, you can do it with this command.

8 depending

MIDI Retrospective Record: 
Insert from All MIDI Inputs

Shift Num *
Inserts (at the cursor's position) what's currently recorded into the buffer from ALL MIDI 
inputs.

10

MIDI Retrospective Record: 
Insert from Track Input as Cycle 

Recording

If you jam with your keyboard over a set cycle (loop, locators range) but you didn't press 
record, you can use this command to insert what you've played as a cycle recording.

9 depending

MIDI Retrospective Record: 
Insert from Track Input as Linear 

Recording

If you jam with your keyboard but you didn't press record, you can use this command to insert 
what you've played as a linear recording. If you've been jamming to a cycle (loop, locators 
range) and use this command, what you played will be inserted as a linear recording and not as 
a cycle recording. (If you played 4 cycles of 4 bars and you give this command, a MIDI part of 16 
bars will be inserted.)

9 depending

Nudge +1 Bar Nudges (moves) the project cursor one bar forward. 10 (I have it set at Ctrl Shift ])
Nudge +1 Frame Nudges (moves) the project cursor one frame forward. 9 depending

Nudge -1 Bar Nudges (moves) the project cursor one bar back. 10 (I have it set at Ctrl Shift [)
Nudge -1 Frame Nudges (moves) the project cursor one frame back. 9 depending

Nudge Cursor Left Ctrl Num -
Nudges (moves) the project cursor left. The amount is dictated by the "Use Quantize" drop-
down menu.

10



Nudge Cursor Right Ctrl Num +
Nudges (moves) the project cursor right. The amount is dictated by the "Use Quantize" drop-
down menu.

10

Panel F2 Brings up the Transport Panel. 10
Much discussion is being made about this 
floating panel ever since it was changed 

Play from Selection End
When you have made a selection and give this command, the project will start playing from the 
end of that selection.

6 depending

Play from Selection Start
When you have made a selection and give this command, the project will start playing from the 
start of that selection.

6 depending

Play Selection Range Alt Space
When you have made a selection and give this command, only this selection will be played. 
Works with range selection and object selection.

10

Play until Next Marker When you give this command, the project will be played up to the next marker. 6 depending

Play until Selection End
When you have made a selection and give this command, the project will stop playing at the 
end of that selection.

6 depending

Play until Selection Start
When you have made a selection and give this command, the project will stop playing at the 
start of that selection.

6 depending

Post-roll from Selection End
When you have made a selection and give this command, playback will start from the end of 
that selection and stop after the time specified in the Post-roll field.

6 depending

Post-roll from Selection Start
When you have made a selection and give this command, playback will start from the start of 
that selection and stop after the time specified in the Post-roll field.

6 depending

Pre-roll to Selection End
When you have made a selection and give this command, playback will start from the end of 
that selection minus the time specified in the Pre-roll field, and will stop at the end of that 
selection.

6 depending

Pre-roll to Selection Start
When you have made a selection and give this command, playback will start from the start of 
that selection minus the time specified in the Pre-roll field, and will stop at the start of that 
selection.

6 depending

Project Synchronization Setup Brings up the Project Synchronization Setup window. 6 depending

Recall Cycle Marker 1 Shift Num 1 Sets the locators to cycle marker 1. 10
Recall Cycle Marker 2 Shift Num 2 Sets the locators to cycle marker 2. 10
Recall Cycle Marker 3 Shift Num 3 Sets the locators to cycle marker 3. 10
Recall Cycle Marker 4 Shift Num 4 Sets the locators to cycle marker 4. 10
Recall Cycle Marker 5 Shift Num 5 Sets the locators to cycle marker 5. 10
Recall Cycle Marker 6 Shift Num 6 Sets the locators to cycle marker 6. 10
Recall Cycle Marker 7 Shift Num 7 Sets the locators to cycle marker 7. 10
Recall Cycle Marker 8 Shift Num 8 Sets the locators to cycle marker 8. 10
Recall Cycle Marker 9 Shift Num 9 Sets the locators to cycle marker 9. 10

Recall Cycle Marker X
Brings up a little window where we type the number of the cycle marker to set the locators to. 
EXCELLENT!

10

Record Num *
Self Explanatory. Where the recording starts is governed by the "Common Record Modes" 
setup.

10



Record: Punch In & Out/Re-
Record

Switches between "Common Record Modes: Punch In/Out" and "Common Record Modes: Re-
record"

6 depending
The way this is command is phrased, 

someone might get the impression that 
this is a super-macro that activates punch 

Record: Start at Cursor/Left 
Locator

Switches between "Common Record Modes: Start Recording at Project Cursor Position" and 
"Common Record Modes: Start Recording at Left Locator/Punch In Position"

6 depending That's a bit more clear than the above.

Restart from Last Stop Position
Sounds self explanatory. In practice, I must set the project cursor somewhere, start playback 
with space, press space again to stop, and then give the command. Then, playback will start at 
where I set the cursor at the very beginning.

6 depending

Return to Start Position
Sounds self explanatory. In practice, I must set the project cursor somewhere, start playback 
with space, press space again to stop, and then give the command. Then, the cursor will return 
to where I had set it at the very beginning.

6 depending

Rewind Num - Self explanatory. 10
Set Left Locator to Project Cursor 

Position
Ctrl Num 1

Sets the coordinates of the Left Locator to be those of the current position of the project 
cursor.

10

Set Marker 1 Ctrl 1 Inserts marker number 1. 10
Set Marker 2 Ctrl 2 Inserts marker number 2. 10
Set Marker 3 Ctrl Num 3, Ctrl 3 Inserts marker number 3. 10
Set Marker 4 Ctrl Num 4, Ctrl 4 Inserts marker number 4. 10
Set Marker 5 Ctrl Num 5, Ctrl 5 Inserts marker number 5. 10
Set Marker 6 Ctrl Num 6, Ctrl 6 Inserts marker number 6. 10
Set Marker 7 Ctrl Num 7, Ctrl 7 Inserts marker number 7. 10
Set Marker 8 Ctrl Num 8, Ctrl 8 Inserts marker number 8. 10
Set Marker 9 Ctrl Num 9, Ctrl 9 Inserts marker number 9. 10

Set Punch In to Project Cursor 
Position

Sets the coordinates of Punch In's position to be those of the current position of the project 
cursor.

6 depending

Set Punch Out to Project Cursor 
Position

Sets the coordinates of Punch Out's position to be those of the current position of the project 
cursor.

6 depending

Set Punch Points to Selection 
Range

Sets the Punch In and Punch Out position to the selection. Works with ranges or object 
selections.

7 depending

Set Right Locator to Project 
Cursor Position

Ctrl Num 2
Sets the coordinates of the Right Locator to be those of the current position of the project 
cursor.

10

Shuttle Play 1/2x Self explanatory 0 ?Not quite working with my keyboard?
Shuttle Play 1/4x Self explanatory 0 ?Not quite working with my keyboard?
Shuttle Play 1/8x Self explanatory 0 ?Not quite working with my keyboard?

Shuttle Play 1x Self explanatory 0 ?Not quite working with my keyboard?
Shuttle Play 2x Self explanatory 0 ?Not quite working with my keyboard?
Shuttle Play 4x Self explanatory 0 ?Not quite working with my keyboard?
Shuttle Play 8x Self explanatory 0 ?Not quite working with my keyboard?

Shuttle Play Reverse 1/2x Self explanatory 0 ?Not quite working with my keyboard?
Shuttle Play Reverse 1/4x Self explanatory 0 ?Not quite working with my keyboard?
Shuttle Play Reverse 1/8x Self explanatory 0 ?Not quite working with my keyboard?



Shuttle Play Reverse 1x Self explanatory 0 ?Not quite working with my keyboard?
Shuttle Play Reverse 2x Self explanatory 0 ?Not quite working with my keyboard?
Shuttle Play Reverse 4x Self explanatory 0 ?Not quite working with my keyboard?
Shuttle Play Reverse 8x Self explanatory 0 ?Not quite working with my keyboard?

Start Enter Self explanatory 10
StartStop Space Self explanatory 10

StartStopPreview In Sample Editor, this command starts/stops the Audition. 6 depending
Stop Num 0 Self explanatory 10

To Cycle Marker 1 Sets the project cursor to the start of cycle marker 1. 10
To Cycle Marker 2 Sets the project cursor to the start of cycle marker 2. 10
To Cycle Marker 3 Sets the project cursor to the start of cycle marker 3. 10
To Cycle Marker 4 Sets the project cursor to the start of cycle marker 4. 10
To Cycle Marker 5 Sets the project cursor to the start of cycle marker 5. 10
To Cycle Marker 6 Sets the project cursor to the start of cycle marker 6. 10
To Cycle Marker 7 Sets the project cursor to the start of cycle marker 7. 10
To Cycle Marker 8 Sets the project cursor to the start of cycle marker 8. 10
To Cycle Marker 9 Sets the project cursor to the start of cycle marker 9. 10

To Cycle Marker X
Brings up a little window where we type the number of the cycle marker on the left side of 
which the project cursor will be set. EXCELLENT!

10

Toggle: Cycle follow when 
locating to Markers

This is a preference: Determines what happens when locating to a marker (NOT a cycle 
marker). When activated, locating to a marker (again NOT a cycle marker) will set the locators 
to a zero range at the marker's position. For example, we have a cycle starting at 1 and ending 
at 5. We have a marker at 9. If we activate the preference and then double click on the marker, 
the cycle will collapse: Left Locator will be set at 9, and Right Locator will be set at 9. Cycle 
always follows when locating to Cycle Markers.

3 depending

Unlock Record Unlocks record if locked. (See Lock Record) 9 depending
Use Post-roll Activates/Deactivates Post-roll. 8

Use Pre-/Post-Roll Activates/Deactivates both Pre-roll AND Post-roll. 9
Use Pre-roll Activates/Deactivates Pre-roll. 8

Use Precount
Activates/Deactivates Precount. (on the tool bar it's "Count-in", same in the right click toolbar 
setup.)

8

Use Tempo Track
Switches between using the Tempo Track and Fixed Tempo. (Or activates/deactivates the 
Tempo Track. You decide.)

8

Use Video Follow Edit Mode
Activates/Deactivates. Per manual: If this option is activated, the project cursor automatically 
follows when you make selections or when you perform editing operations.

8

Video
Mute all video tracks Mutes/Unmutes the Video Track. 8

VRPlayerRemote
GoPro VR Player Remote Brings up the GoPro VR Player Remote. 8

Window Zones



Show/Hide Left Zone Ctrl Alt L, Alt I Self explanatory. 10
Show/Hide Right Zone Ctrl Alt R Self explanatory. 10
Show/Hide Upper Zone Ctrl Alt U Self explanatory. 10
Show/Hide Lower Zone Ctrl Alt E, Ctrl Alt B Self explanatory. 10

Show/Hide Trasport Zone Ctrl Alt T Self explanatory. 10
Show Previous Tab Ctrl Alt Left Self explanatory. 10

Show Next Tab Ctrl Alt Right Self explanatory. 10
Show Previous Page Ctrl Alt Up, Page Up Self explanatory. 10

Show Next Page Ctrl Alt Down, Page Down Self explanatory. 10
Show/Hide Info Line Ctrl I Self explanatory. 10
Show/Hide Overview Alt O Self explanatory. 10

Show/Hide Status Line Self explanatory. 10
Show/Hide Regions Self explanatory. 10

Windows
Close All Self explanatory 5 depending

Close All Plug-in Windows Self explanatory 5 depending
Maximize Self explanatory 5 depending
Minimize Self explanatory 5 depending

Minimze All Self explanatory 5 depending
Restore All Self explanatory 5 depending

Select Next Plug-in Window Self explanatory 8 depending

Show/Hide Desktop
Self explanatory. This is about Cubase's background. It will switch to allow you to see your 
desktop and switch so that you don't see your desktop.

5 depending

Show/Hide Plug-ins Self explanatory 9 depending
Workspaces

New Ctrl Num 0 Self explanatory. 10
No Workspace Alt Num 0 Unloads workspaces. 10

Organize Brings up the Workspaces Organizer Panel. You can work with it open. 7

Update Workspace Alt U
If you make changes to a workspace and then give this command, the workspace will be 
updated, and the changes you made saved into it.

10

Workspace 1 Alt Num 1 Directly launches Workspace 1 10
Workspace 2 Alt Num 2 Directly launches Workspace 2 10
Workspace 3 Alt Num 3 Directly launches Workspace 3 10
Workspace 4 Alt Num 4 Directly launches Workspace 4 10
Workspace 5 Alt Num 5 Directly launches Workspace 5 10
Workspace 6 Alt Num 6 Directly launches Workspace 6 10
Workspace 7 Alt Num 7 Directly launches Workspace 7 10
Workspace 8 Alt Num 8 Directly launches Workspace 8 10
Workspace 9 Alt Num 9 Directly launches Workspace 9 10

Workspace X Ctrl Alt Num 0 Brings up a little window in which we type the number of the workspace to load. EXCELLENT! 10

Zoom



Redo Zoom Redoes a Zoom Undo 10 (I have it assigned to Alt Z)
Undo Zoom Undoes Zoom 10 (I have it assigned to Ctrl Alt Z)

Zoom 4 Tracks Zooms so that 4 tracks fit the screen vertically. 6 depending ? In my case, 3 tracks fit on the screen. ?
Zoom 8 Tracks Zooms so that 8 tracks fit the screen vertically. 6 depending ? In my case, 7 tracks fit on the screen. ?

Zoom Cycle Marker 1 Zooms to Cycle Marker 1 so that it fits the screen horizontally. 8 depending
Zoom Cycle Marker 2 Zooms to Cycle Marker 2 so that it fits the screen horizontally. 8 depending
Zoom Cycle Marker 3 Zooms to Cycle Marker 3 so that it fits the screen horizontally. 8 depending
Zoom Cycle Marker 4 Zooms to Cycle Marker 4 so that it fits the screen horizontally. 8 depending
Zoom Cycle Marker 5 Zooms to Cycle Marker 5 so that it fits the screen horizontally. 8 depending
Zoom Cycle Marker 6 Zooms to Cycle Marker 6 so that it fits the screen horizontally. 8 depending
Zoom Cycle Marker 7 Zooms to Cycle Marker 7 so that it fits the screen horizontally. 8 depending
Zoom Cycle Marker 8 Zooms to Cycle Marker 8 so that it fits the screen horizontally. 8 depending
Zoom Cycle Marker 9 Zooms to Cycle Marker 9 so that it fits the screen horizontally. 8 depending

Zoom Full Shift F
Zooms horizontally so that the whole project (start of first event to the end of the last event) 
fits on the screen horizontally.

10

Zoom In H
Zooms in horizontally. The target, the focal point, the place where the zooming occurs is the 
Project Cursor.

10

Zoom in On Waveform Vertically Alt H Makes waveforms in events bigger. 10

Zoom In Tracks Ctrl Down
This command acts upon the vertical size of the selected track(s), enlarging them by one row 
each time.

10

Zoom In Vertically Shift H This command actus upon the vertical size of all tracks, enlarging them by one row each time. 10

Zoom MEM
This command MEMorizes the current zoom situation. Position, vertical zoom, horizontal 
zoom. You can later recall the memory using Zoom ZAP. A very very useful 1-2 combination.

10 (I have it assigned to Ctrl F1)

Zoom N Tracks
Brings up a little window where we select the number of tracks. That is the number of the 
tracks we need to fit on screen.

7 
? In my case, when I type N tracks, I get N-
1 traks fitting on the screen. I don't know 

Zoom Out G
Zooms out horizontally. The target, the focal point, the place where the zooming occurs is the 
Project Cursor.

10

Zoom Out of Waveform 
Vertically

Alt G Makes waveforms in events smaller. 10

Zoom Out Tracks Ctrl Up
This command acts upon the vertical size of the selected track(s), shrinking them by one row 
each time.

10

Zoom Out Vertically Shift G This command actus upon the vertical size of all tracks, shrinking them by one row each time. 10

Zoom Preset 1 Instantly recalls Zoom Preset 1. 8 depending
Zoom Preset 2 Instantly recalls Zoom Preset 2. 8 depending
Zoom Preset 3 Instantly recalls Zoom Preset 3. 8 depending
Zoom Preset 4 Instantly recalls Zoom Preset 4. 8 depending
Zoom Preset 5 Instantly recalls Zoom Preset 5. 8 depending
Zoom to Event Shift E Zooms the respective editor to fit the selected event. 10



Zoom to Locators Zooms to the locators' position. 9

Zoom to Selection Zooms horizontally AND vertically, so that the current selection fits the screen. 10 depending
Even though the name is "Zoom to 

Selection" and the manual says that Shift 

Zoom to Selection Horizontally Alt S This command will only zoom horizontally, so that the current selection fits the screen. 10
This is the command that is assigned the 
default Alt S, called Zoom to Selection. 

This command is better than the above, in 
Zoom Tracks 1 Row Directly sets the track height to 1 row. 8 depending
Zoom Tracks 2 Rows Directly sets the track height to 2 rows. 8 depending
Zoom Tracks 3 Rows Directly sets the track height to 3 rows. 8 depending
Zoom Tracks 4 Rows Directly sets the track height to 4 rows. 8 depending

Zoom Tracks Exclusive Z
Greatly increases the track height of the selected track(s). All other tracks are shrinked to 1 
row. (unless something's off with my preferences)

10

Zoom Tracks Full Shrinks the track height of all tracks, sot that they can all fit in one screen vertically. 8 depending
? I'm getting -1 track for all of them to fit. 
That is, if I have 16 tracks, only 15 will fit. 

Zoom Tracks Minimal Shrinks the track height of all tracks to minimal. 8 depending

Zoom Tracks N Rows
Brings up a "Type in number of rows" window, where we type the number of rows we wish all 
tracks to be in size. 0 will set them to minimal, 2 to the default etc.

9 depending

Zoom ZAP Recalls the Zoom snapshot saved when you used "Zoom MEM". 10 (I have it assigned to Shift F1)


